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From all the emails we receive it’s 
clear most of you have upgraded 
to Windows 10 without a hitch, 
but that there are some common 
annoyances along the way… 
These could be something as 
easy as how to find a program 
you only run once in a blue 
moon, or something a bit more 
in depth, such as how to claim 
back all the space that your old 
version of Windows is still taking 
up on your hard drive. That’s 
why, this issue, we have a special 
feature on fixing your common 

Windows 10 upgrade problems. 
We also have a new section 
designed for anybody who is 
new to Windows 10 and just 
wants to find out how the latest 
system works. And don’t forget 
to check out the list of top 
keyboard shortcuts in there!  
So, if you’re new to Windows 10, 
then turn to page 91 and  
get stuck in!

Enjoy the issue and I’ll  
see you next month when 
we’ll look at networking 
in Windows 10. 

Welcome

SUBSCRIBE TO THE MAG TODAY  
AND SAVE – JUST TURN TO PAGE 32!

We pride ourselves in being the only 
magazine on the shelves to show you  
exactly how to get the very best from
the Windows operating system, whether 
you’re using Windows 10 or Windows 8.1. 
Also, don’t forget to take a look at how  
you can read the magazine on your laptop, 
phone or tablet.
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28 Organise your photos and 
videos in the new Windows 10 

34 How to take regular backups 
of your entire hard drive

38 Speed up your system for 
better performance

40 tweak your photos with the 
adobe photoshop express app

44 How to recover lost or 
accidentally deleted files

48 Find out how to password 
protect certain folders

50 lock down Windows 10 to 
keep your information private

54 Discover music with the new 
Groove app in Windows 10

58 Welcome to Microsoft edge, 
Windows 10’s new browser

60 tips for browsing the web 
with Microsoft edge

Your guide Graham Barlow says…

“If you’re looking for better ways to use your home 
computer, then this is the place to start. We’ll show 
you all the tips and tricks the experts use and more!”
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 NEW thiNgs to do  amaziNg WEbsitEs  fasciNatiNg facts

Home videos 
Livestreams such  
as Google Hangouts 
on Air are a great 
way to talk to many 
people at once
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The Knowledge…

To start an internet stream you’ll need a 
computer with a webcam and 
microphone, as well as a fairly decent 
internet connection. Most modern laptops 
and even phones and tablets are up to the 
task. Google’s Hangouts On Air is an easy 
to way to create a stream. A prerequisite 
for this is a Google account, but if you 
don’t already have one you can sign up at 
accounts.google.com/signup. Next, visit 
plus.google.com/hangouts/onair.

How livestreaming is 
taking over the internet

Going Live

L
ivestreaming is one of the hottest 
buzzwords on the internet at the 
moment. YouTube has launched its 
own livestreaming channel, while 

apps such as Meerkat and Periscope turn 
smartphones into broadcast systems. But 
what actually is livestreaming?

Simply put, a livestream is an as-it-
happens feed of video and audio, much 
like television. However, unlike television 
it’s broadcast over the internet rather than 
the airwaves, and 
there are billions of 
streams to choose 
from. If you’ve ever 
watched a show live 
on BBC iPlayer you’ve 
seen a livestream, 
and if you’ve taken part in a Skype 
conversation with video then you’ve 
created your own.

Thanks to advances in broadband  
and mobile internet speeds, as well as 
improving hardware, livestreams have 
become more interesting over the last 
couple of years. Meerkat and Periscope  
are the most popular smartphone 

livestreaming apps, using devices’ 
cameras to create an ongoing video feed.

As it happens
You normally need to download their apps 
to create and view, but there are web 
viewers available at meerkatstreams.com 
and onperiscope.com. They offer a new 
perspective on what’s going on around the 
world – one stream we caught came from 
a mobile phone as it travelled down the 

conveyor at an 
airport security 
check-in.

Meanwhile, 
gamers are catered 
for with twitch.tv. 
This streaming site 

was bought by Amazon for $970 million 
last year, and it attracts 43 million viewers 
every month. And while it’s easy for 
non-gamers to dismiss twitch, it can be 
entertaining and as adrenaline-pumping 
as any other live sport. The fresh-faced 
gaming.youtube.com does the same thing, 
but it’s a little easier to set up if you want 
to try your hand at game streaming.

the web has become alive with constant video feeds. We 
look at the best sites, and show you how to start your own

Google OnHub
Why is there a vase in this magazine?
That’s no vase. It’s actually a wireless 
router for use in the home. Dubbed 
Google OnHub, it’s the latest product from 
the search engine giant.

That can’t be a wireless router because it 
doesn’t look like a rejected piece of 
military hardware.
OnHub’s slick looks are one of its big 
selling points. The antennae are usually on 
display, but here they’re concealed within 
its cylindrical housing. And rather than 
featuring more blinking lights than a 
town-centre Christmas tree, its status is 
reflected via a subtle glowing ring on top.

is setting it up needlessly complex, like 
most wireless routers?
No, and this is another of its advantages. 
Connect it to your phone line and turn it 
on and the rest is handled via a simple 
smartphone app. You can also use this to 
allocate bandwidth, so your streaming TV 
series can take priority over your kid’s 
shoot ‘em up.

How does the onHub compare with a 
normal router?
Pretty favourably. In reviews its ease of  
use is matched by decent range and fast 
speeds. It’s also future-proof, so it’ll handle 
Bluetooth Smart Ready, Weave, and 
802.15.4 – the technologies that will power 
internet-connected smart homes.

When can i get one?
Google hasn’t announced a UK release 
date and price for OnHub yet, but it’s 
available in the US for $200 (£130). There 
will be more coming soon, too – this  
one’s manufactured by TP-Link, but Asus 
has partnered with Google for another 
router later this year. Maybe it’ll look like a 
bowl of potpourri.

HAnGin’ ouT Click ‘Create a Hangout on Air’,  
and sign into Google if prompted

And ACTion! Click ‘start’ to begin your event. 
Copy the page’s address to share your hangout

TiTLe CArd Add a title and description for your 
hangout. You can also schedule it for the future

Start a Stream Chat with anyone via Hangouts

twitch.tv can be hugely 
entertaining and as 

adrenaline-pumping as 
any other live sport

Discover
Livestreaming online
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HENRY WINCHESTER 

TECH EXPERT

Top tip Lost in translation

Struggling to get something to work? Need a tip? 
Then email us your woes (to windowsmagazine@futurenet.com with the subject line 
‘Windows Insider’) and we’ll share your perfect Windows tweaks in a future issue.

Speech-to-text has become the holy grail 
of computing, but you have to invest in 
software such as Dragon’s NaturallySpeaking 
to transcribe large chunks of speech. There 
is, however, a YouTube hack that allows  
you to use the internet video service to turn 
your voice into text. Simply upload your 
speech files, as videos, to the site. After a 
while you’ll be able to view the text by 
clicking ‘More’ followed by ‘Transcript’ under 
the video. It’s not perfect: sometimes the 
translation can be a bit iffy, and it’ll only work 
with videos of 20 minutes or under. But it’s a 
great solution if you want to save yourself the 
rigmarole of transcribing.

Free speech-to-text 
via YouTube

One of Windows 8’s Start Screen’s biggest 
foibles is its layout, which means it’s easy to 
overlook cool apps installed on your 
computer as you head straight to traditional 
Windows programs. Fortunately there’s a 
way to see all your Windows programs in 
one Window. Simply right-click on the 
desktop, select ‘New’, then ‘Shortcut’, Now 
type Explorer Shell:AppsFolder, in the 
Location box. Click ‘Next’ then enter a name, 
such as ‘All Apps’, then choose ‘Finish’. You’ll 
see a new icon on your desktop, and you can 
click this to quickly get to any program, be it a 
Windows App or a program or game.

Apps folder  
for desktop

Device Manager is Windows’ one-stop shop 
to check all your computer’s components 
and peripherals. To access it click the Start 
button, then type device manager and click 
the first result. You’ll now see a complete list 
of your computer’s hardware, organised by 
category. Anything that’s playing up will 
sport a yellow exclamation mark. Right-click 
on these dodgy devices and choose ‘Update 
Driver Software’, and Windows will try to find 
the correct drivers. If this doesn’t fix the issue, 
try the device manufacturer’s website. You 
can find out who made the device by 
right-clicking and choosing ‘Properties’.

Master Device 
Manager

One of Windows 10’s best features is 
Cortana, the voice-activated personal 
assistant. Setting it up is simple – click 
the Windows button, then type 
‘Cortana’ and follow the instructions.

However, we found Cortana didn’t 
work on one of our computers – it said 
our region and language wasn’t 
supported. If you encounter this, click 
the Windows button, type ‘Settings’ 
and click the icon. Now choose ‘Time & 

Language’. Click ‘Region & Language’, 
then select ‘Add a language’. Pick 
‘English’, then choose the ‘United 
Kingdom’ option. Once it’s installed 
choose ‘Options’, then ‘Speech’ and 
download the language pack. 

Restart your computer, type 
Settings to get to the ‘Time & 
Language’ options. Click ‘Speech’, 
then pick ‘English (United Kingdom)’. 
Now you can set up Cortana.

Get Cortana running in the UK
Microsoft’s awesome Windows assistant might not 
work for some. Here’s how to get her going

ASk me Anything 
Question Cortana on 

everything from today’s 
weather to ancient 

egyptian history
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W
hen it comes to in-car 
technology we’ve progressed 
miles beyond the standalone 
satnav, and we now have 

entire computers embedded into the 
dashboard. Pick up one of this year’s 
models and you’re likely to find a smart 
display that lets you know your car’s 
location, speed, status, and access your 
music collection and messages.

This is just the beginning of a 
revolution. Earlier this year Nokia’s Here 
Maps service was 
bought by Audi, 
BMW and 
Mercedes for $3 
billion, with the 
aim of using it to 
control self-driving 
cars. There are 
rumours Apple is 
working on a car, 
and Google is 
currently testing 
autonomous vehicles on American streets.

The advantages of self-driving vehicles 
are numerous. An autonomous car can go 
further without the driver getting tired. 
An array of sensors ensure hazards are 
reacted to more quickly than a human 
could, while automated braking safely 
brings the vehicle to a halt. 

More advanced ideas include the 
ability for the car to drop its passengers 

off and then drive itself to a quiet area to 
park, or driverless trucks freighting 
goods around the country.

The biggest obstacle facing driverless 
car manufacturers is one of trust. 
Driving is an isolated and personal 
experience, and inviting an artificial 
entity to transport your nearest and 
dearest is an understandable concern. 
There are also concerns that driverless 
cars could go wrong – just one 
catastrophe could completely undo the 

public’s faith in 
such vehicles.

Safety is 
absolutely 
paramount to tech 
companies, of 
course. But new 
cars already 
include features 
such as automatic 
parking, and the 
shift into fully 

autonomous vehicles is likely to be a 
gradual slide. Simple manoeuvres are 
likely to come first, then it’ll be able to 
tackle more problematic infrastructure 
such as Swindon’s magic roundabout. 
Estimates from the car companies 
believe self-driving cars are about 10 
years away, but in the meantime there 
will be a lot of exciting innovations in the 
automobile industry.

As the major tech companies invest in vehicles we look at 
the pros and cons of these tech-heavy four wheelers

Google Drive

1Google’s logo was 

recently updated – 

but what colour is the 

first G?
A. Blue
B. Red
C. Yellow

2Apple’s first logo, 
from 1976, depicted 

which famous scientist?

A. Albert Einstein
B. Isaac Newton
C. Alexander Graham Bell

3 What is Sony’s 
current slogan?

A. “Just do it”
B. “Be moved”
C. “I’m lovin’ it”

4Why did Airbnb’s 
new logo spark 

controversy this year?

A. It looks rude
B. It looks like another 
company’s logo 
C. It suggests Airbnb is  
an airline

5Which other-worldly 

being forms 
Snapchat’s logo?
A. A ghost
B. An alien
C. A vampire

6What was the 
Windows icon called 

in Windows Vista and 7?

A. The Windows Prong
B. The Windows Brick
C. The Windows Orb

Pens at the ready, your time starts now!The 60-Second Quiz

Answers 1A. 2B. 3B. 4A. 5A. 6C. 

The cars of the future CopyPasteCharacter
copypastecharacter.com

Your computer’s keyboard may have 104 
keys, but there’s an astonishing amount of 
extra hidden characters available to 
spruce up your communications. 
Windows has a built-in character map for 
weird and wonderful symbols, but it’s 
tricky to use and it includes a lot of 
useless characters.

This is where CopyPasteCharacter.com 
comes in handy. Click on a symbol on 
this site and it’ll be added to your 
clipboard so you can paste it ([Ctrl]+[V]) 
into any text-based file. There’s an 
amazing array of special characters 
on offer, including snowmen, smiley 
faces and playing cards, and you can 
use the dropdown menu to switch to 
different categories such as currency 
and shapes. It also includes emojis, the 
more up-to-date smiley symbols which 
include different foodstuffs, activities 
and animals.

Smiley people Use this site to add symbols 
to emails, letters and instant messages

Discover
It’s good to talk
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People not fe
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Video games
haVe been
blamed for…

HenryWinchester reveals a
hostof fascinatingdigital facts

The number of pixels you’ll find
in Sony’s Xperia Z5 Premium
smartphone. It’s the first phone
to feature a 4K display, which
means it has the same amount of
pixels as a high-end television -
albeit packed into a 5.5-inch
display. Other features include a
23 megapixel camera, a
fingerprint sensor, and a dust and
waterproof chassis. As expected,
it comes with a premium price
tag, too - it’ll set you back £629
for a sim-free model.

8,294,400

| November 2015| November 2015

HowHappy are
tecH employees?

The tech industry may have hip offices and high
salaries, but its workers are miserable. According to a
survey, only 19 per cent felt happy at work, only 17
per cent felt valued, and fewer than 50 per cent rated
their relationship with coworkers as strongly positive.

£14.42
The amount 10 septims from video
game series The Elder Scrolls would be
worth in the real world. Website Mobile
Money worked out exchange rates for
virtual coins. Pokemon dollars were
best value, with 10 being equal to
two pence, while 10 Orens from
The Witcher would be £2.50.



Gossip site Gawker and its parent company 
Gawker Media were launched in 2003 by British 
journalist Nick Denton.

For the first five years Denton ran the company 
from his home in SoHo, New York, before 
moving to an office in Nolita, Manhattan.

Gawker Media is responsible for nine blogs: 
Gawker.com, Deadspin (sports), Lifehacker 
(productivity), Gizmodo (gadgets), io9 (sci-fi), 
Kotaku (gaming), Jalopnik (cars), Jezebel 
(feminism) and Sploid (‘brain candy’).

Each blog has its own set of sub-blogs. io9, for 
instance, includes science, animals, toys and 
true crime.

The site has frequently courted controversy. 
Director Quentin Tarantino tried to sue it over 
its publication of his script for The Hateful Eight.

And wrestler Hulk Hogan has launched a  
$100 million lawsuit over Gawker’s leaking of  
his sex tape.

Gizmodo hasn’t been immune from controversy 
either – in 2010 it bought a prototype iPhone 4 
for $5,000. It later returned the smartphone.

The sites draw a combined 105 million visitors 
per month, which helps them generate $40 
million a year in revenue.

Denton stood down as CEO in December 2014 
but is now worth an estimated $300 million.

Top gawker facTs

would you TrusT a roboT To 
look afTer your children?
When Sky questioned customers about sentient 
machines, 15 per cent of men said they’d trust an  
AI robot to babysit, while three per cent of women 
agreed. 15 per cent of men said they could have  
an emotionally fulfilling relationship with one, but 
only two per cent of women said the same. 

whaT were The mosT 
popular passwords 
of 2014?
1. 123456
2. password
3. 12345
4. 12345678
5. qwerty
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Discover 
Facts & figures
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Of children in the US have received their first 
internet-connected device by the age of 13, 
and 51 per cent have one before their 10th 
birthday. The research, conducted by online 
security company AVG, found three in four 
parents have talked to their kids about the 
dangers of the internet, but just 41 per cent 
have installed a block on their kids’ devices. 
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indows 10 blends the 
best features of Windows 
7 and 8.1 together, but 
there are still potential 
hurdles to overcome if 
you truly want to enjoy 

it. In this feature we’ve rounded up 32 
annoyances you’re likely to come across 
with your new operating system, which 
you might want to change. You’ll discover 
how to restore features taken out of 
Windows 10, such as the DVD Player  
or Windows Media Center, make sure  
settings are correctly applied to protect 
your privacy and security, plus resolve 
issues with the minimum of fuss.  
Once you’ve worked your way 
through our list, you’ll have a PC 
that’s working for you, not the other 
way round. Without further ado, then, 
it’s time to get Windows 10 firmly in line…

Windows 10 fixes –  
your problems solved
There’s lots to like about Windows 10, but you can make it  
even better by eliminating some common annoyances

W

Switch System 
Restore back on
Don’t ask us why, but Windows 10 disables 
System Restore by default. The first thing to 
do, then, is switch it back on. Press the 
[Windows]+[Pause/Break] keys together to 
open System Properties and click ‘System 
Protection’ in the left-hand column. You 
should see Protection Settings have been 
switched off for all your drives. Locate your 
Windows drive (it should be marked ‘System’) 
and click the ‘Configure…’ button. Select ‘Turn 
on system protection’ and allocate up to 10% 
of your available space using the slider. Click 
‘OK’ twice to finish the job.
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Create a  
reinstall disc
It also pays to be able to reinstall 
Windows from scratch should you need 
to. You’ll need a blank DVD or spare 8GB 
USB flash drive. First, download the 
Windows 10 Media Creation Tool from 
www.microsoft.com/en-gb/software-
download/windows10 – choose the 
32-bit or 64-bit depending on your 
system type (press [Windows]+[Pause/
Break] and look under System if you 
don’t know this). Now launch the tool. 
Select ‘Create installation media for 
another PC’, click ‘Next’ and follow the 
prompts to select your language, edition 
and architecture (32-bit or 64-bit). Insert 
your USB flash drive, or create an ISO file 
you can then burn to a single DVD.

Make recovery disc
What happens if Windows 10 fails to boot? 
You need a system recovery drive that gives 
you access to Windows 10’s repair options. 
You can create a full-blown reinstall disc with 
these tools (see the next tip) or you can press 
a spare 1GB USB flash drive into service 
instead with just the repair utilities in place. To 
do the latter, plug the drive into your PC, then 
type ‘recovery’ into the Search box and click 
‘Create a recovery drive’ under Settings. 
Untick ‘Back up system files to the recovery 
drive’ ticked and follow the prompts to create 
your drive. Should you need to use it, restart 
your PC with the drive plugged in to access 
the tools.

Bring back 
Libraries
The Libraries feature may be niche, but it 
can also be incredibly useful. If you’ve 
upgraded from Windows 7 you may be 
wondering where they’ve gone – 
thankfully they’re still present, but 
hidden by default. To bring Libraries 
back, open a File Explorer window and 
switch to the View tab on the ribbon. 
Click the ‘Navigation pane’ button on the 
left and choose ‘Show Libraries’.
Note, Libraries can also be seen if you 
have ‘Show all folders’ ticked – they’ll 
appear under the ‘This PC’ section in the 
Navigation pane.

Windows 10 fixes
Your problems solved
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Restore the  
Start screen
If you prefer the full-screen Start screen 
experience from Windows 8 and 8.1, click 
‘Start > Settings’ and go to 
‘Personalisation > Start’. Flick the ‘Use 
Start full screen’ to ‘On’ and when you 
next click the Start button the menu will 
appear full-screen, with the tiles given all 
the space they need. Click the menu 
button in the top left-hand corner to 
reveal the new Start menu’s left-hand 
pane with the shortcuts to ‘Most used’ 
and ‘Recently added’ apps, plus File 
Explorer, Settings and power buttons as 
well as the ‘All apps’ menu.

Where’s your 
product key
If you’ve taken advantage of the free 
Windows 10 upgrade offer, then you 
won’t have been given a product key.  
You won’t need it going forward – you 
can note it down using Belarc Advisor 
(www.belarc.com), but what you’ll 
discover is it’s identical to everyone else 
who has upgraded to the same version  
of Windows (whether it’s Home or Pro)  
as you. Should you need to reinstall 
Windows, skip the bit where you’re asked 
for a product key and Microsoft will 
recognise your PC as legitimate and 
activate it with no problem.

Save bandwidth
Did you know that Windows 10 uses 
peer-to-peer technology to deliver 
Windows updates? What this means is 
your internet connection is used to share 
updates you’ve downloaded with other 
users. If you’re on a slow broadband 
connection, or you’d rather not let 
Microsoft do this you can change it. Click 
‘Start’ and choose ‘Settings’. Select 
‘Update & Security’ and click ‘Advanced 
options’ under Windows Update. Next, 
click ‘Choose how updates are delivered’ 
and either switch the feature off or select 
‘PCs on my local network’ to further cut 
bandwidth usage by only sharing the 
updates between PCs in your home.
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Customise the 
hidden Start menu
Like Windows 8 before it, Windows 10 
has a hidden Start menu – press the 
[Windows]+[x] keys or right-click the Start 
button to access it. The menu includes 
handy shortcuts to hidden parts of your 
system such as the old Control Panel, Run 
dialogue box and Event Viewer. But why 
stop there? Add your own, or rearrange 
and delete existing shortcuts courtesy of 
the Win+X Menu Editor. Download the 
zip file from http://winaero.com/
download.php?view.21, right-click it  
and choose ‘Extract All’ to save it to a 
suitable folder.

Restore classic 
Start menu
If you’ve upgraded from Windows 7, you 
might not like the new Start menu at all. 
If you’re hankering for the ‘classic’ style, 
then download and install Classic Shell 
from www.classicshell.net. During 
installation, untick all entries except 
‘Classic Start Menu’ and ‘Classic Shell 
Update’. Once it’s installed, click the Start 
button to configure it – the default 
settings should be fine, so click ‘OK’. The 
classic Start menu blends in with the 
Windows 10 look, but provides settings 
and shortcuts you’ll be more familiar with 
– there’s even a shortcut to the Windows 
10 Start menu too.

Lose the File 
Explorer ribbon
We’ve loved the File Explorer since its 
introduction in Windows 8, but if you’re 
not a fan of its ribbon interface, then you 
can disable it and restore the Windows 7 
look using a program called 
OldNewExplorer – download it from 
http://tihiy.net/files/OldNewExplorer.rar. 
You’ll need a program capable of 
extracting RAR files to use it – try 7-Zip 
(www.7-zip.org). Once extracted, launch 
the program and click ‘Install’, then tick 
the various boxes to change how File 
Explorer looks – close and reopen any 
File Explorer windows to see the effects.

Windows 10 fixes
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Where has the 
Charms bar gone?
Windows 8’s Charms bar – accessible 
from the right-hand edge of the desktop 
– has disappeared in Windows 10…  
For those who miss it, here’s where  
you find its tools now: first, the Power 
and Settings buttons are accessible 
directly from the Start menu itself, while 
the Search box on the Taskbar replaces 
the Search charm. Other Charms, 
including Settings, Share and Print are 
now incorporated into Microsoft Store 
apps – some apps make them available 
via the hamburger-like menu on the 
app’s title bar; otherwise they’re hidden 
inside the app itself.

Disable Cortana
There’s little doubt the Windows 10 
search bar is useful, but it links into 
Microsoft Cortana by default. If you 
decide you don’t like Cortana’s additional 
tools, reduce its functionality to that of 
previous versions of Windows: click the 
search bar to open Cortana. If you’re 
using it for the first time, click ‘Not 
interested’ to disable it; otherwise, click 
the Settings button and flick the ‘Use 
Cortana’ switch to ‘Off’. You can also 
disable the web portion of Windows 10’s 
search capabilities from here too, 
restricting searches to files, programs 
and settings on your PC.

Add shortcuts
Once extracted, browse to the x64 
(64-bit) or x86 (32-bit) folder, then 
double-click WinXEditor.exe to start 
tweaking. Click the ‘Add a program’ 
button and choose ‘Add a program’ to 
manually browse for a program, or ‘Add 
preset’ for options such as shutdown and 
restart entries. You can also easily add 
individual Control Panel applets and 
administrative tools, including Disk 
Cleanup, Task Scheduler and more. 
Organise applications into groups, and 
remove any you don’t need. Click ‘Restart 
Explorer’ to update the menu, or ‘Restore 
defaults’ to undo all your changes if you 
make a mistake.
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Tighten privacy 
in Edge
If you stick with Edge, there are some 
important privacy settings you need to 
switch on before relying on it. Launch the 
browser, then click the ‘…’ button in the 
top right-hand corner and choose 
‘Settings’. Scroll down and click 
‘Advanced settings’ and make sure the 
‘Block pop-ups’ slider is set to ‘On’. While 
you’re here, flick ‘Send Do Not Track 
requests’ to ‘On’, then set Cookies to 
‘Block only third-party cookies’ for 
greater privacy.

Change default 
app by file type
If your app isn’t listed when trying 
to set it as the default via Settings, 
try this instead: browse to a file you 
want to open, then right-click it and 
choose ‘Open with > Choose 
another app’. Then tick the ‘Always 
open this app…’ box before 
selecting your chosen default. If it’s 
not in the list, click ‘More apps’ to 
reveal more choices, and if your 
chosen program still isn’t there, 
click ‘Look for another app on this 
PC’ to manually select it. Start your 
search under Program Files or 
Program Files (x86).

Change default 
apps in Settings
After upgrading to Windows 10, 
Microsoft changes your default browser 
to Edge. To fix this manually, click ‘Start > 
Settings > System > Default apps’. Click 
the Edge entry and then pick your 
browser from the list that pops up. You 
can change other key app defaults here: 
video, photo, mail and so on. For a wider 
range of app choices, click ‘Set defaults 
by app’. Advanced users can also set 
defaults by file type or protocol using the 
appropriate links.

Windows 10 fixes
Your problems solved
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Bring back Gadgets
There are many good reasons for leaving 
Gadgets alone – some can pose a security 
risk after all – but if you’ve upgraded from 
Windows 7 and can’t live without them, you 
can restore them using 8GadgetPack 
(http://8gadgetpack.net), which also works 
in Windows 8/8.1. Not only does it restore 
full Gadget functionality, but you gain 
modern improvements such as support for 
high-DPI screens, allowing you to resize 
your gadgets for larger displays.

Access classic 
Display settings
We’re not massive fans of the new 
Personalisation dialogue, which is now 
part of Settings. If you’ve a hankering for 
the Display Settings dialogue from 
Windows 7 and 8, create a shortcut to it 
on the desktop: right-click some blank 
space and choose ‘New > Shortcut’. Type 
the following into the Location box:
control.exe desk.cpl,Settings,@Settings

Click ‘Next’, give it a suitable name and 
click ‘Finish’, then use this shortcut to 
tweak display settings.

Customise the 
Start menu
Alternatively, take the time to make the 
Start menu your own using the 
‘Personalisation > Start screen’. Click 
‘Choose which folders appear on Start’ to 
pin folders to the Start menu. You can 
also resize the Start menu to alter its 
height and width – just click and drag on 
its top or right-hand edge to do so. Drag 
it to the right to add columns to display 
more of your tiles on-screen at once. You 
can then pin apps from the ‘All apps’ list 
here (right-click the app and choose ‘Pin 
to Start’), then drag them into groups or 
whatever order you choose.
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Restore Briefcase
It had niche appeal, but the Briefcase was 
one of the earliest tools for keeping data 
synced between two locations. While it’s 
been removed from Windows 10 (and 8), 
you can get it back again with a Registry 
tweak. Download the required file from 
http://winaero.com/blog/wp-content/
uploads/2012/09/Briefcase.zip. 
Double-click it to open it, then 
double-click Windows 8-Enable Briefcase.
reg. Click ‘Run’ followed by ‘Yes’ twice, 
then restart Explorer via Task Manager to 
restore its features. Note, it doesn’t work 
well with User Account Control, so don’t 
create Briefcases inside any 
administrator-protected folders.

Bypass login
If you’re the only user of your PC  
and you’d like to boot straight to the 
desktop without having to enter your 
password each time, here’s what to do. 
First, press [Win]+[R] to open the Run 
dialogue box, then type netplwiz and 
press [Enter]. Make sure your user 
account is selected, then untick ‘Users 
must enter a username and password to 
use this computer’ and click ‘Apply’. Enter 
your user password and click ‘OK’ twice. 
Windows will also require you to enter 
your password after your PC wakes from 
sleep. If security isn’t an issue, click ‘Start 
> Settings > Accounts > Sign-in options’ 
and change the ‘Require sign-in’ 
dropdown menu to ‘Never’.

Restore Windows 
Photo Viewer
Microsoft has replaced Windows Photo 
Viewer with the Photos app, but it’s 
possible to restore it as an option when 
setting the default app for photos. It’s a 
convoluted process – see ‘Method 4’ at 
www.askvg.com/tip-restoring-windows-
photo-viewer-as-default-in-windows-10/ 
but, the site provides a ready-made zip 
file containing the required Registry 
entries. Download this to your hard drive, 
then open it to access the .reg file within. 
Double-click this and choose ‘Run’ 
followed by ‘Yes’ (twice) – to make 
Windows Photo Viewer an option again.

Windows 10 fixes
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Restore classic  
[Alt]+[Tab] switcher
Press [Alt]+[Tab], and Windows 10 
displays a list of thumbnails for all open 
windows. If you’d rather stick with the 
old look, press [Win]+[R] and type 
‘regedit’ to open Registry Editor. Browse 
to the following key: HKEY_CURRENT_
USER\SOFTWARE\Microsoft\Windows\
CurrentVersion\Explorer. Now select  
‘Edit > New > DWORD (32-bit) Value’. 
Name it AltTabSettings. Double-click  
the value and set it to 1. Now restart 
Explorer from Task Manager to restore 
the icon task switcher.

Replace Windows 
Media Center
Windows Media Center has also been 
dropped from Windows 10. There are 
plenty of free alternatives, but our 
personal recommendation is Kodi  
(www.kodi.tv), which also has a built-in 
DVD player. If you have a TV tuner 
attached to your PC for watching and 
recording live television, then you’ll  
also need NextPVR (www.nextpvr.com) 
along with the CCCP pack (http://www.
cccp-project.net/). 

Visit http://kodi.wiki/view/NextPVR for 
a guide to pairing NextPVR with Kodi. 

Watch DVDs  
on your PC
Windows Media Player loses the ability  
to play DVD video in Windows 10 (as  
it did in Windows 8 before it). You can 
purchase Microsoft’s Windows DVD 
Player for £11.59 from the Store, but  
why do that when VLC Media Player 
allows you to watch DVDs – including 
non-region 2 discs – for free?  
Just download and install it from  
www.videolan.org/vlc. Before you play 
any movies, open the Video menu and 
choose ‘Deinterlace > Automatic’ to 
improve the picture quality. 
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Tame Quick 
Access
The Quick Access menu replaces both 
Recent Places and your Favourites folder 
in File Explorer’s Navigation pane, but it 
can be a bit of a mess, mixing pinned 
icons, frequently accessed folders and 
recent items. Open File Explorer, switch 
to the ribbon’s View tab and click 
‘Options’. You can disable the latter two 
items via the Privacy boxes, plus instruct 
File Explorer to open to the This PC view 
instead of Quick Access if you wish.
You can also pin the old Recent Places 
shortcut to Quick Access too: press 
[Win]+[R], type ‘%AppData%\Microsoft\
Windows\’ and press [Enter]. Right-click 
the Recent Items shortcut and choose 
‘Pin to Quick Access’.

Resolve any 
HomeGroup issues
A number of people have struggled  
to connect to their existing HomeGroup 
after upgrading to Windows 10. Start  
by running the HomeGroup 
troubleshooter, which you can access via 
the HomeGroup Control Panel (type 
‘homegroup’ into the Search box to 
locate it). If this doesn’t yield a solution, 
Google ‘homegroup problems’ and click 
the first result in the list (‘HomeGroup 
problems in Windows – Windows Help’). 
Work your way through the suggestions 
underneath ‘I can’t create, join or use a 
HomeGroup’ – don’t worry that it’s 
written for Windows 8; the solutions 
apply equally to Windows 10 too.

Disable  
Wi-Fi Sense
If you connect wirelessly to your 
network, then the Wi-Fi Sense feature, 
which connects you to crowdsourced 
Wi-Fi hotspots and networks shared by 
your contacts, is enabled by default if 
you choose Express Settings during the 
Windows 10 upgrade process. It’s 
designed to make it easier to connect to 
friends’ networks through your 
Facebook, Outlook.com or Skype 
contacts list, but if you’d rather not share 
this information, make sure you disable 
it. Click ‘Start > Settings > Network & 
Internet > WiFi’. Click ‘Manage WiFi 
Settings’ and flick both switches to ‘Off’ 
to prevent your network details being 
shared with others.

Windows 10 fixes
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Restore Solitaire
Microsoft has made Solitaire freemium in 
Windows 10 – you’ll need to download 
the app from the Store, then pay a 
subscription fee to remove the ads. If this 
is too much, try Solitaire Collection Free 
from the Store instead – it’s also 
ad-supported, but you can pay a one-off 
fee of £2.29 to remove them. If you’d 
rather play on your desktop, then 
download 123 Free Solitaire from 
www.123freesolitaire.com instead – the 
download you want is the second on the 
download page. This is ad-free, and 
comes with 12 games. Configure how it 
works by clicking ‘Game > Autoplay’ and 
exploring ‘Tools > Options’.

OneDrive changes
One of the best features of OneDrive in 
Windows 8 was the ability to use 
‘placeholders’ for certain folders, 
effectively giving you access to your 
stored files without having to also hold a 
copy on your hard drive. Sadly Windows 
10 ditches this feature (for now); instead 
you need to specify which folders you 
want to keep synced on your PC. To do 
this, right-click the OneDrive icon in the 
Taskbar Notification area and select 
‘Settings’. Switch to the Choose Folders 
tab and click the ‘Choose Folders’.  
Untick ‘Sync all files and folders on my 
OneDrive’ and then tick only those 
folders you need access to.

Improve the 
Windows Update
By default Windows Update now delivers 
all updates automatically. While you can’t 
put them off indefinitely, go to ‘Settings 
> Update & Security > Windows Update 
> Advanced Options’. Windows 10 Pro 
users can select ‘Defer upgrades’ to put 
off non-security updates for several 
months. Windows 10 Home users should 
set ‘Choose how updates are installed’ to 
‘Notify to schedule restart’ to get alerts 
that updates are about to be installed. 
Home users with Wi-Fi connections can 
also postpone updates by going to 
‘Settings > Network & Internet > WiFi > 
Advanced Options’ and flicking the 
‘Metered Connection’ switch to ‘On’ until 
you’re ready to update.
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Recover hard  
drive space
Once you’re up and running with 
Windows 10, and convinced you won’t 
need to go back to your previous version 
of Windows, it’s time to free up drive 
space. Open File Explorer, go to This PC, 
right-click your C drive and choose 
Properties, then click the Disk Clean-up 
button. As soon as the dialog opens, click 
‘Clean up system files’ and wait for it to 
scan again. Go through the list ticking 
those items you don’t need – the biggest 
item by far will be ‘Previous Windows 
installation(s)’. Tick this to free up space, 
but remember there’s no going back 
once the files are gone.

Run older apps
Most apps that work in Windows 7 and 8 
should also work in Windows 10, but if 
your app won’t work then all may not be 
lost. If you still have access to a non-OEM 
copy of an older version of Windows,  
you can install it in a virtual machine 
courtesy of VirtualBox (www.virtualbox.
org). This basically lets you create a 
virtual PC inside Windows 10, into which 
you can install your old programs while 
you look for a compatible update or 
suitable alternative.

Remove  
unwanted apps
Windows 10 ships with a number of 
built-in apps such as Mail, Money and 
Groove Music. If you don’t like any of 
these, Microsoft doesn’t provide an 
Uninstall option. However, you can still 
ditch them with the help of IOBit 
Uninstaller 5 (www.iobit.com/
advanceduninstaller.php). 
Once installed, open the app from the 
‘Start menu > All apps menu’, then select 
Win Manager from the left-hand menu 
and select Windows Apps. Expand the 
Windows Apps section where you’ll see 
all the apps listed. Click the dustbin next 
to one to remove it. Any apps can be 
restored later through the Store.
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Learn how to…
Organise  
your media

“Connecting your devices and 
using powerful apps will make 
finding what you want a breeze”

hese days most people  
have multiple devices,  
with multiple ways to  

take photos, play music and record 
videos, so it’s more important than 
ever to stay well organised. 
Otherwise, before you know it, you’ll 
have gathered a huge library of 
media, and no way to easily find what 
you want without trawling through 
endless folders.

Fortunately, Windows 10 is making 
it easier to stay on top of things. The 
basis of the new system remains the 
same with folders – now called 
Pictures, Music and Videos – that 
you’ll be familiar with from previous 
versions of Windows. There is also 
seamless integration with Microsoft’s 
universal OneDrive, which safely 
backs up files in the cloud, while 
linking your devices. Added to that, 
however, are new easy-to-use apps, 
such as Photos and Groove Music. 
Here’s how to get organising.

1 Set up OneDrive
If you’ve set up your Microsoft account, you’ll have access to 

Microsoft’s cloud storage service, OneDrive. If not, sign up at www.
onedrive.com. You get 15GB of free storage, which rises to 1TB if 
you’re an Office 365 subscriber. Next, install the OneDrive app on 
your phone and tablet, then set your device to automatically 
upload photos and videos to your OneDrive account.

2 Find your desktop app
You’ll discover the new Photos app within the Start menu. It 

should be one of the blue tiles on the right, unless you’ve already 
got some snaps on your PC, or in your OneDrive account, in which 
case it will feature one of those pictures. If you can’t spot it, click 
‘All apps’ in the bottom-left of the menu and scroll down. It’s the 
same process for the apps we’ll talk about later.

Step-by-step Get super organised by getting connected

Your guide Andrew Westbrook  says…

COlleCtiOn
This holds your 
images,  arranged  
in reverse 
chronological order. 

Date SearCh
For a quicker search, 
click the date to 
bring up a list of  
the months when 
you’ve imported 
your photos.

albumS
This is where the  
app separates your  
photos into several 
basic folders, starting 
with Camera roll, 
Saved pictures and 
Screenshots. 

SettingS
You can alter settings 
such as what image 
shows on the Start menu 
tile, where the app looks 
for pictures and whether 
it auto-enhances. 

T
Anyone can do it 
Straightforward
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

at a glance…
SKill leVel

time taKen

Suitable fOr

60 minutes
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3 Exploring Photos
If you haven’t added any pictures yet, you’ll be met by a plain 

screen. On the left are the Collection and Album menus – click into 
‘Albums’, and you’ll see it’s split into Camera roll and Screenshots. As 
soon as you import photos, or enable OneDrive on your phone or 
tablet, the app will add those snaps. Imported OneDrive files are 
also saved locally, in ‘Local Disk > Users > OneDrive’.

4 Importing photos
To retrieve photos from a memory card, plug it into your PC. 

Windows will ask where you’d like to import your photos to. Select 
‘This PC > Pictures’, then ‘Import’. Your media will be imported into 
the folder. Next, open the Photos app, which will automatically 
grab all the images. The app will also automatically add them to 
your online OneDrive account.

Jargon buster!
 Cloud

Storage services,  
such as OneDrive, 
that back up your 
data online. Keeping 
files in the cloud 
means they’re safe if 
your PC dies, plus 
you can access them 
from any machine 
with web access.

 import
The process of 
adding files to your 
PC or an app, for 
example from a 
memory card or  
USB stick.

 app
Applications are 
self-contained 
programs. The term 
is usually associated 
with smartphones 
and tablets, but has 
been adopted by 
desktop PCs.

View, eDit, Share
Click on an image to 
enlarge it. You can 
also share, print or 
make it your 
background, plus 
use the editing tools. 

impOrt anD SeleCt
These buttons offer quick 
ways to import more 
photos, check for new 
photos to be imported 
and select individual or 
multiple images. 

AndreW’s best tip!
don’t neglect Onedrive. 
spend an hour or so, every 
now and then , deleting 
unwanted files and creating 
logical subfolders.

Explore 
Organise your media
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9 Music in the cloud
Groove Music isn’t automatically linked to OneDrive. If you’re 

confident you have enough storage and want to connect it, stay in 
Settings and click ‘Choose where we look for music’. Making sure 
you’re logged in, hit ‘OneDrive’. The app will now sync your songs, 
making it easy to have one music collection for all your devices. Just 
remember to save enough storage for your photos.

7 Groove Music
Music has been given an overhaul, due to the end of 

support for Windows Media Player. And Windows 10 has a new 
music app called Groove Music, which will be self-explanatory if 
you’ve used music players before. Like the Photos app, it helps 
you organise your collection and playlists in one location. Again, 
you’ll find the app through one of the tiles in the Start menu.

5  Arranging folders
Photos organises your images into folders – ‘Camera roll’ 

sorts them by date; ‘Saved pictures’ are ones you’ve edited; and 
Screenshots, which you take by hitting [Windows]+[Print Screen]. 
It’s a good idea to add subfolders to the source folders. In Pictures, 
right-click anywhere, hit ‘New > Folder’, fill in a name and drag in 
the relevant files. Do the same in OneDrive, using the ‘New’ menu.

10 Videos
Return to the Start menu and hit the ‘Film & TV’ tile. This app 

is a media player for watching TV shows or movies you buy 
through the Store. It’s also home to your own videos. It will 
automatically search the Videos folder on your PC, but, like 
Groove Music, you can also link it to OneDrive. Hit ‘Settings’, in the 
bottom-left, click ‘Where to look for videos’, then add OneDrive. ■

8  Finding your music
When you first open the app, it will automatically search 

your PC, adding songs to your library that it finds in your Music 
folder, and organising them. You can also add any song already 
bought on other devices linked to your account, or any iTunes 
playlist already created. To do that, click the Settings cog in the 
bottom-left of the app, then toggle the Downloads option to ‘On’. 

6 Easy access
Now, with minimum hassle, all of your images, from your 

phone, tablet and PC, are stored and organised on your PC and 
remotely in the cloud. This makes life simpler and more secure, 
while also making it easy to move your collection if you switch PC. 
You can even see your snaps in camera-roll form and stream 
videos by logging into OneDrive, if you can’t access your own PC.
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Learn how to…
Make a fail-
safe backup

“Take regular backups of your 
entire hard drive with Macrium 
Reflect Free to avoid disaster”

rive images are an essential 
part of your backup plan 
because they take an exact 

copy of your entire hard drive – the 
problem with the Windows Backup 
tool is that each drive image it takes  
is a completely new copy of your 
drive, taking time to complete and 
eating up precious hard-drive space 
in the process.

Macrium Reflect Free offers a 
number of advantages over Windows 
Backup, most notably support for 
differential backups. These only 
record the changes made since the 
last full backup was taken, which not 
only speeds up the backup process, 
but also leaves more free space on 
your backup drive too.

In this tutorial we’ll show you how 
to set up Reflect Free to back up your 
drive, then – if the worst happens 
– restore the latest backup so you can 
quickly recover from a crash or simply 
undo your most recent changes.

1 Download Macrium Reflect
Download the program installer (ReflectDL.exe) from 

macrium.com/reflectfree.aspx by clicking the green ‘Download 
Now’ link. Once saved, double-click the file to open the Download 
Agent. Make sure ‘Free’ is selected, and that the ‘Selected 
Download’ reads ‘Reflect Installer and PE Components’ – if not, 
click ‘Options’ to select it. Click ‘Download’ followed by ‘Yes’.

2 Complete installation
Once the files have downloaded, click ‘Next’ and follow  

the setup wizard. If you don’t want to, you don’t need to register 
to use the product.After, click ‘Finish launch Reflect’ from the  
Start menu by typing reflect into the search box. When  
prompted again to register, simply click ‘Do not remind me’ to  
go to the main screen.

Step-by-step Back up and restore using Reflect

Your guide Nick Peers  says…

Select iMage
Switch to the 
‘Restore’ tab in 
‘Reflect’, then locate 
the image you wish 
to recover files from. 
Click the ‘Browse 
image’ link. 

chooSe drive(S)
Tick the drive or 
drives you wish to 
access. Make a note 
of its drive letter,  
or click to choose 
your own. 

Full acceSS
To gain full access to 
the drive, make sure 
you tick the ‘Enable 
access to restricted 
folders’ box. 

D
Anyone can do it 
Straightforward
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

at a glance…
SKill level

tiMe taKen

Suitable For

30 minutes
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3 Set up rescue options
The first step is to provide recovery options allowing you to 

restore your backup should Windows fail to load. Open the ‘Other 
Tasks’ menu. To add an option to launch ‘Reflect’ when your PC 
starts, choose ‘Add Recovery Boot Menu Option…’ and follow the 
prompts. Select ‘Windows PE 5.0’ if you’re running Windows 8 or 
later; ‘Windows PE 3.1’ for Windows 7 or earlier. Click ‘OK’.

4 Prepare boot media
You should also create a rescue disc for added insurance 

against hard drive failure. You’ll need a blank CD or DVD, or a 
small (512MB or larger) USB flash drive. The flash drive needs to 
be blank and formatted correctly. Plug it in, open File Explorer, 
right-click the drive and choose Format. Select ‘FAT32’ under ‘File 
System’ and click ‘Start’.

Jargon buster!
 differential image

A backup that 
records the changes 
made since a full 
drive image was 
taken. The full drive 
image must be 
present when 
restoring this image.

 drive image
A backup that 
records an exact 
byte-for-byte copy of 
a hard disk or 
partition, including 
information about  
its type, size and 
other attributes.

 Windows Pe
A cut-down version 
of Windows that 
provides a 
troubleshooting  
and recovery 
environment when 
Windows won’t load.

acceSS FileS
Once mounted, your 
image can be 
accessed like any 
other drive – just 
locate your files and 
copy them off. 

identiFy driveS
Mounted images 
can be easily 
identified in File 
Explorer by the 
Reflect icon that’s 
assigned to them. 

unMount drive
When you’re finished 
recovering data, 
right-click the drive and 
choose ‘Macrium 
Reflect > Unmount 
Macrium Image’. 

Nick’s best tiP!
When the boot menu appears 
on startup, click ‘Change 
defaults...’ followed by 
‘Change the timer ’ to shorten 
the wait.

Explore 
Make a fail-safe Windows backup
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9 Update your backup
Reflect will now update your backup to the schedule you 

chose earlier, but you can also create backups manually whenever 
you want – just before installing a major update, for example. To 
do so, switch to the ‘Backup Definition Files’ tab, right-click your 
backup XML file and choose ‘Run Now > Prompt’. Choose ‘Full’ or 
‘Differential,' add a comment, then click ‘Finish’.

7 Choose backup type
The default backup settings will use a mixture of full and 

differential backups to give you a choice of restore options going 
forward. Click ‘Add Schedule > Full’ – by default, a monthly 
schedule is set, so click ‘OK’ (or tweak if necessary). Now click ‘Add 
Schedule > Differential’ to create a weekly schedule. Click ‘Next’, 
review your settings and click ‘Finish’.

5  Create rescue disc
Now select ‘Other Tasks > Create Rescue Media’ in ‘Reflect’. 

Verify the PE version is correct (see step three) and click ‘Change 
PE Version’ if necessary. Click ‘OK’ followed by ‘Next’, verify core 
drivers (network and disk primarily) are selected and click ‘Next’. 
Choose your media (CD or USB), tick ‘Enable multiboot…’ if using 
USB and click ‘Finish’.

10 Restore options
There are two basic options when it comes to restoring 

data. To recover individual files from your backup, mount the 
image file as a virtual drive in Windows following the annotation 
on the previous page, then simply copy the files you want from 
here back to your hard drive. If you need to roll back your entire 
Windows system, however, read on…

8  Run backup
Give your backup a suitable name, make sure both boxes 

are ticked and click ‘OK’. You’ll be prompted to enter your account 
password to allow the schedule to be set, so Reflect can back up 
automatically in the background. Do so, then click ‘OK’ and wait 
while the first backup is taken. Once complete, it will verify the 
image isn’t corrupt – your PC is now protected!

6 Take first backup
Next, click ‘Create an image of the partition(s) required to 

backup and restore Windows’ under ‘Backup Tasks’. Click the ‘…’ 
button to select a dedicated folder on your backup drive. Click 
‘Advanced Options’, select ‘Auto Verify Image’ and tick the ‘Verify 
image…’ box. Use ‘Comments’ to help identify the backup. Click 
‘OK’ followed by ‘Next’.
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15 Review and restore
Click Next to review your proposed changes. Click 

‘Advanced Options’ for additional options such as verifying the 
image prior to restoring it – note that the ‘Rapid Delta Restore’ 
option isn’t available in the free edition. Once done, click ‘Finish’, 
review the warning and click ‘Continue…’ Your backup will be 
restored – choose ‘File > Exit’ to reboot when done.

13 Image current state
Restoring a drive image basically wipes out everything that 

was on the drive before – if there’s data you need to protect, take 
a fresh drive image. Switch to the ‘Disk Image’ tab, then untick 
everything except the drive you plan to restore (typically C). Click 
‘Image selected disks on this computer’ and follow the prompts to 
back up to your backup drive.

11  Restore your backup
While it’s possible to start the restore process from within 

Windows (switch to the Restore tab), it’s better to restore a system 
image from outside of Windows in the recovery environment. If 
you added the recovery boot menu option in step three, restart 
your PC – when the boot menu appears, choose ‘Macrium Reflect 
System Recovery’ and jump to step 13.

16 Your PC, protected
Congratulations. You now have a fail-safe – and 

automatically updated – backup that will help minimise data loss 
and disruption going forward. No more hours lost to reinstalling 
Windows from scratch and setting up your PC again after a crash; 
now the most you’ll lose is a week’s work – or even less if you pair 
Reflect with Windows’ File History tool. ■

14  Select backup to restore
Once done, switch back to the ‘Restore’ tab. If your  

list of images isn’t present, click ‘Browse for an image file…’  
tolocate it manually on your backup drive. Click ‘Restore  
Image’ and Reflect should attempt to automatically select  
the correct disk; if not, click ‘Select a different target disk’ to 
manually choose it.

12 Use the boot media
If you can’t boot to the recovery environment, then use your 

rescue disc or USB drive. Insert it prior to starting up your PC then 
look for a message that prompts you to access the boot menu – 
typically it’s pressing a key like [F11]. Use the cursor keys to select 
your drive from the list of available options and hit [Enter] to load 
from it.

Explore 
Make a fail-safe Windows backup
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Learn how to…
Speed up an old  
PC in five minutes

“ReadyBoost is a free way to speed up your system 
using a USB stick, and it’s great for extending the life 
of your PC. Here’s how to make the most of it!”

here’s nothing more 
frustrating than realising 
your once-speedy computer, 

which served you well just a few 
months ago, is starting to feel slow 
and unresponsive. Don’t worry 
though – you don’t need to fork out 
for an upgrade just yet. Windows 
offers a quick and easy solution. 
ReadyBoost is a useful built-in tool 
that uses removable flash memory, 
such as USB sticks and SD cards, as 
extra RAM to speed up your system.

In Windows 7 or 8, the amount of 
memory that can be used for 
ReadyBoost has been given a huge 
increase, and you can now use more 
than one form of removable memory, 
giving you extra scope to speed up 
your machine. It’s particularly useful 
for systems running with less than 
2GB of RAM, such as netbooks.

1 Insert your USB stick
First, make sure that you have your choice of removable 

flash memory to hand. To start the ReadyBoost process, you 
need to insert your USB stick into your computer and wait for 
the AutoPlay menu to appear. If you’re opting to use an SD card 
instead, just place it into the slot on your laptop or desktop PC, 
or use an external card reader. 

2 Choose ReadyBoost
Once the AutoPlay window pops up, you can start using 

ReadyBoost. The relevant option appears at the bottom of the list, 
where you’d normally choose to either browse the device or load 
images from an SD card straight into Windows Live Photo Gallery. 
When you click on the ‘Readyboost’ option, you’ll be taken 
straight to a configuration screen.

Your guide Dan Grabham says…

T

Dan’s best tip
For a permanent performance 
boost, consider upgrading 
your pC’s RAM. Learn how 
at http://bit.ly/1pz8koA.

Step-by-step Give your PC an instant speed boost

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7

At a glance…
SKILL LEVEL

TImE TAKEn

SuITAbLE for

30 minutes
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7 Double up
In Windows Vista, ReadyBoost only supported one device 

with a capacity up to 4GB, but with Windows 7 or 8 you can use 
multiple fast devices, with nearly unlimited memory. If your 
laptop or desktop computer has an SD card that’s unused for 
the majority of the time, why not consider making this a semi-
permanent ReadyBoost slot?

8 Enjoy!
You should now have a noticeably more responsive 

computer, and be able to perform daily tasks faster than before. 
Although Readyboost won’t help you transform a basic machine 
into a gaming behemoth, you should feel a real change in your 
system’s performance, and it might even stave off the need for a 
new computer for a little while to come. ■

5 Partition a USB device
If you still want to be able to use your USB stick’s memory 

for storing your documents, photographs and other files, but 
you also need to speed up your computer, a different option is 
required. This will have a less dramatic effect than making it a 
dedicated device, but can still be helpful. Insert your USB stick or 
SD card and click the ‘Speed up your system’ option as before.

3 Create a dedicated device
If you’re planning on using this USB flash drive just for 

ReadyBoost and don’t intend to store any data on it as well, you 
should turn it into a dedicated device. To do this, simply check 
the second option in the list, ‘Dedicate this device to ReadyBoost’. 
This option makes all of the USB drive’s storage space available to 
be used by Windows.

6 Slide to increase
You can use the slider to allocate a portion of the disk’s 

space to ReadyBoost, while still leaving a certain amount of room 
for your files. Move the slider left or right until you’re happy with 
the amount of space. We wouldn’t recommend dedicating less 
than 256MB to ReadyBoost, otherwise you won’t see much 
difference in the speed of your system.

4 Prepare it for use
Now that your USB stick is a dedicated device, it’s ready 

to give your computer the performance boost it so badly needs. 
Click ‘OK’ and your device is prepared for use by the system. From 
now on, whenever you insert that drive into your PC, Windows 
recognises it and adds its capacity to the system, so your 
computer has more memory to use.

Explore 
Speed up your PC
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Learn how to…
Tweak photos 
to perfection

“Make your snaps shine with the 
Adobe Photoshop Express app”

dobe Photoshop is the tool 
of choice for professional 
photographers the world 

over. Its toolset gives experts total 
control over their pictures, enabling 
them to tweak and edit their shots to 
perfection. That kind of power 
doesn’t come cheap though, plus the 
app takes a long time to master.

That’s where Photoshop Express 
comes in. This fantastic Windows app 
is like a cross between Photoshop 
and Instagram, with simple but 
effective tools to help you correct 
common flaws, plus it has an array of 
fun filters for a touch of vintage flair. 
There are a few paid-for options, but 
the majority of its tools and features 
are free. It’s easy to use, with a simple 
interface ideal for mice and fingertips 
alike. Visit the Windows store to 
download it, and let’s get started!

1 Pick a pic
You can add a picture from your hard drive, the camera of 

your Windows device, or Revel – Adobe’s image backup and 
sharing service. Here, we’re going for an image from our Pictures 
library. Select your photo, then click ‘Open image’. You’ll now be 
presented with the editing screen. If you can’t see the tool icons, 
click your photo once to make them visible.

2 Compose and crop
Select the ‘Crop’ icon at the bottom left and handles will 

appear at each corner of your picture. While cropping snaps, bear 
in mind the rule of thirds (http://bit.ly/1h9rrEh) to help create 
more dramatic-looking images. You can also use the Crop tool to 
rotate your image – ideal if you’ve snapped your picture with a 
phone held at a jaunty angle.

Step-by-step Make your snaps shine

Your guide Cat Ellis says…

Back
Click here at any time to 
return to the main editing 
window and choose a 
different tool. You won’t 
lose any of the edits 
you’ve made so far. 

ToolBox
These tools let you 
crop, straighten and 
colour-correct your 
images. You can also 
apply special filters 
called ‘Looks’. 

A
Anyone can do it 
Straightforward
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

at a glance…
SkIll lEVEl

TImE TakEn

SuITaBlE for

30 minutes
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3 Changed your mind?
Once you’ve finished cropping and straightening, click the 

‘Back’ arrow at the top left to return to the main editing screen. 
If you change your mind about any of the edits you’ve made, 
simply tap the ‘Undo’ arrow at the top right; none of the changes 
you’re making will become permanent until you save the picture 
at the end.

4 Compare and contrast
Select the ‘Correct’ tool and three tabs will appear – 

Contrast, Exposure and White Balance. Select ‘Contrast’ to adjust 
contrast, clarity and vibrance. Contrast is the difference between 
the brightest and darkest parts of your image, clarity makes the 
midtones in your image lighter or darker (resulting in a softer or 
‘harder’ effect), and vibrance is colour saturation.

Jargon buster!
 White balance

Compensating for 
tints caused by 
coloured lighting  
in photos by  
making sure that 
white objects  
really are white.

 overexposed
A very bright picture 
lacking in detail, 
created when a 
subject is too bright 
for the camera’s 
current settings.

 Instagram
An online photo- 
and video-sharing 
site, best known  
for its image filters 
that mimic pictures 
taken with old  
film cameras.

In-app purchaSES
Any icons with blue 
price-tags indicate 
features that must 
be paid for. The 
sharpening tool is 
one example. 

auTo fIx
If you’re in a hurry, this 
option will analyse 
your picture and 
attempt to create a 
good balance of colour 
and contrast for you. 

VIEW orIgInal
Click and hold this 
button to see what 
your picture looked 
like before you 
started editing it in 
Photoshop Express. 

SaVE/SharE
Once you’ve finished, you 
can share your snaps online 
with a few clicks or taps – or 
just store it on your PC. 

Cat’s best tip!
any icon with a blue price 
tag attached indicates a 
feature that ’s only accessible 
via an in-app purchase. 
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9 Share and enjoy
Click and hold the ‘View original’ button at the bottom left 

to see the differences your edits have made to your photo. Once 
you’re happy, select ‘Share/save’ and choose whether you’d like to 
save it to your PC, or share it on Facebook or Revel. If you choose 
Facebook, you can then enter a caption and share your polished 
snap with the world.

7 Auto-correct
The final corrective action you can take is red-eye repair. 

This eliminates the effect produced when light from a camera 
flash reflects off the eyeball. Select this option, then click the 
centre of each eye to fix it. If all those sliders and options sound 
like too much effort, you can simply click ‘Auto fix’ and the app will 
attempt to create a good balance of light, shade and saturation.

5  Decent exposure
Selecting the Exposure tab will reveal three sliders – 

Exposure, Highlights and Shadows. These aim to replicate the 
effect of more or less light hitting the sensor in your camera. It can 
be a useful way to brighten up a picture taken on a dull day, but it 
can never restore a part of the picture that’s in total darkness. The 
same is true of overexposure, where the highlights are white.

10 Next, please!
If you’d prefer to store your picture locally, just choose a 

location, enter a filename and click ‘Save’. The editor will close  
and you’ll be ready to start perfecting another picture! 
Congratulations, you now know how to make your favourite 
snaps look amazing, and share them with your family and  
friends – all with only a few taps or clicks! ■

8  New looks
Instagram is best known for its retro-style image filters, 

which are a great way to liven up your shots. Photoshop Express 
has a similar selection of options, known as ‘Looks’. There are lots 
of free Looks, plus an array of premium ones that can only be 
previewed (not applied) unless you’re willing to pay. If you like the 
paid-for options, click the shopping cart icon to buy it.

6 Balancing act
Indoor lighting is rarely white, and different types of 

lighting can tint your photos. For example, an incandescent 
lightbulb gives off warmer (more orange) light than a fluorescent 
bulb. The ‘White balance’ tab can help counteract this effect. The 
Temperature slider makes images more orange (warm) or blue 
(cold), and the Tint slider shifts it towards purple or green.
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Learn how to…
Recover lost or 
deleted data

“If you’ve lost access to a drive  
or accidentally deleted files,  
then DMDE could save the day”

ata recovery is a tricky 
business. There can be no 
going back for accidentally 

deleted data or a lost hard drive, and 
there’s no guarantee your files are in 
a state to be successfully recovered. 
However, there are some free tools 
available that can give you a chance 
of recovering documents, photos and 
other irreplaceable files. And one of 
the best is DMDE – Free Edition.

This is a powerful tool that does 
more than simply recover deleted 
files – it can also enable you to  
access hard drives that are still 
physically working but are no longer 
visible to Windows. If DMDE can see 
the drive, it enables you to copy  
your files and folders from it, often 
without losing any data at all. In this 
tutorial I’ll show you how to use the 
program to access your drive, find 
lost files and – hopefully – recover 
working copies of them.

1 Download and extract
DMDE is a portable tool, which means you can run it from 

any drive. Open your browser and navigate to www.dmde.com/
download.html and click the ‘Download DMDE for Windows’ link. 
Save the zip file to any drive other than the one you’re trying to 
recover data from. Right-click the downloaded zip file and choose 
‘Extract All’ to extract its contents.

2 Launch DMDE
Open the extracted folder and double-click dmde.exe to 

launch the program, clicking ‘Yes’ when prompted. Leave ‘English’ 
selected and click ‘OK’. Accept the license agreement and you’ll be 
asked to select the drive you wish to recover data from. If the 
drive is visible in Windows, select ‘Logical Disks’ followed by the 
drive letter and click ‘OK’.

Step-by-step How to recover data with DMDE

Your guide Nick Peers says…
DiRectoRy tRee
Use this pane to 
browse the currently 
selected drive or 
partition – folders 
marked with a red dot 
contain deleted items. 

FolDeR winDow
This is where the 
contents of the 
currently selected 
folder – or the 
results of a search 
– are displayed. 

D
Anyone can do it 
Straightforward
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance…
SKill leVel

time tAKen

SuitAble FoR

30 minutes
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3 Select physical drive
If the drive appears in Device Manager, but doesn’t show up 

in Windows and can’t be assigned a drive letter using Disk 
Management, then leave ‘Physical Disks’ selected. Click each 
Physical Drive entry in turn and DMDE will display information 
about its type and size, helping you identify the missing drive. 
Select it and click ‘OK’.

4 Select partition
DMDE will scan the drive for partitions. Don’t be surprised if 

errors appear (click ‘OK’ to clear them) and then a number of 
possible matches – some similar or seemingly identical – should 
appear. Select the partition you’re looking for using the volume 
name (and drive letter if applicable), partition status, f.system and 
size to identify it.

Jargon buster!
 current panel

The term DMDE uses 
to describe the 
currently selected 
folder. Note, data can 
only be recovered 
from this folder in 
the Free Edition.

 File system
A means of 
organising, storing 
and retrieving data 
from a hard disk. File 
systems include 
NTFS and FAT32.

 wildcard
A special character 
used to help match 
strings using flexible 
criteria. The ‘?’ 
character replaces a 
single character, 
while ‘*’ is used to 
substitute one or 
more characters.

typeS oF File
Choose ‘exclude 
deleted’ to only find 
current files; or 
‘deleted only’ to 
restrict your search to 
previously erased files. 

File FilteR
Use this box to 
search for specific 
files or file types 
(separate using 
semi-colons). 
wildcard characters 
are supported. 

File Size limitS
Tick this box to 
restrict your search to 
files of a certain size 
– enter figures in 
bytes (1,024 bytes = 
1KB, 1,024KB = 1MB). 

Help
Click this button to 
access DMDE’s 
comprehensive online 
manual. It’s a little 
technical, but explains 
difficult concepts. 

Nick’s best tiP!
if no obvious partitions can 
be found, use the ‘NtFs 
search’ and ‘FAt search’ 
buttons to see if DMDE can 
locate them.

Explore 
Recover lost or deleted data
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9 Recover your data
Click the ‘Size’ button to get an estimate of how much space 

your recovered items will require, then click ‘…’ to select a different 
drive with enough space to recover them to (never recover files  
to the same drive). Make sure ‘include deleted’ is selected if 
applicable and finally click ‘OK’ to attempt file recovery. Wait  
while the files are copied.

7 Search for specific items
Alternatively, click the ‘Search Panel’ button (with the 

magnifying glass) to open a Search window. Use the file filter to 
define your search – use wildcards if you’re not sure about a file’s 
exact name, or to search by file type (such as *.doc). Use the 
annotation to help refine your search further, then click ‘OK’ to let 
DMDE scan for matches.

5  Construct virtual file system
Click ‘Open Volume’. After a second scan, a dual-paned 

window will open. On the left are three entries – to view all 
recoverable data from the drive (including deleted files), double-
click [All Found + Reconstruction]. In most cases clicking ‘OK’ at 
this point is sufficient, but advanced users can click ‘Parameters’  
to tweak settings if necessary.

10 Your data, restored
Once complete, a dialogue box will display the results of 

your recovery. Browse to the folder where your recovered files are 
and see if you can open them – not all files can be recovered 
sadly, but if the file was only recently deleted then your chances 
of success are greater. Return to DMDE to continue recovering 
other files and hopefully save the day! ■

8  Select what to recover
The Free Edition allows you to recover files one of two ways: 

you can select up to 4,000 files from a single folder by opening it 
in the right-hand pane, selecting the files you want to recover and 
choosing ‘Tools > Recover’. If recovering files from a search, you 
must recover each file individually by right-clicking it and 
choosing ‘Recover the Object…’

6 Browse for recoverable items
You can now explore your drive’s contents via the expanded 

$Root directory. Click the arrow next to a folder to expand it, or 
double-click the folder to view its contents (including files) in the 
right-hand pane. Look out for folders with red dots – these 
contain deleted files, so double-click to explore. Deleted files are 
clearly marked by a red ‘x’.
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Learn how to…
Keep your PC  
folders protected

“Locking folders from being accessed on your own 
user account is not part of Windows by default. 
Folder Password Expert helps keep your data safe”

older Password Expert is a 
program that allows you to 
protect folders against 

unwanted access. It can lock folders 
on an internal hard drive, flash drive, 
external USB drive and network drive. 
When folders are password protected 
and locked, their contents cannot be 
read, copied, modified or deleted. To 
access the locked folders, you must 
supply the correct password.

Folder Password Expert guarantees 
your privacy by making it impossible 
for anyone to access your data – even 
in Windows Safe Mode. If somebody 
logs on under your Windows account, 
they will not be able to access your 
data without that crucial password, 
which for added security is not stored 
anywhere in Windows. To download 
the program, go to www.folder-
password-expert.com and click ‘Try It 
Free’ in the top-left. Once installed, 
select ‘Run Trial Version’ to use the 
30-day trial ($39.95 thereafter).

1 Lock folders
On the Welcome screen, deselect ‘Show this screen each 

time Folder Password Expert starts’, otherwise you’ll be constantly 
reminded to upgrade. Click on ‘Next’. You’ll then need to choose a 
task (‘Lock folders’ or ‘Unlock folders’). Choose ‘Lock folders’ and 
click ‘Next’. On the next screen, click on ‘Add’ and browse to the 
folder or folders that you want to lock and click ‘OK’.

2 Enter password
Choose ‘Next’ and you will be asked to enter a password. 

You’ll notice that if you tick the option below the password fields, 
you can enter a password hint. When choosing a hint, ensure that 
only you will understand it. Click on ‘Next’ and you will be told 
that your folders have been locked. Click ‘Next’ again and you’ll 
see the ‘Select a Task to Perform’ screen again.

Your guide Christian Hall says…

F

CHristian’s best tip
secure folders larger than 
4Gb by formatting your drive 
in ntFs. Each file in the 
folder must be under 4Gb.

Step-by-step Lock and unlock folders in Folder Password Expert

Anyone can do it 
Straightforward
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance…
SKILL LEVEL

TImE TAKEn

SuITAbLE for

10 minutes
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7 Secure a USB or network drive
As well as being able to secure folders found on any drive or 

partition on your PC, you can also secure folders on a network-
attached hard drive or one connected by USB. Simply navigate to 
the folder using Windows Explorer, right-click and choose to lock 
or unlock folders. Remember that any network-attached drive will 
need to be discoverable in Windows Explorer.

8 Trial version notes
To unlock the full version from the trial one, you’ll need to 

enter the code that you receive after purchase (there’s a ‘Paste 
from the Clipboard’ option) and then click ‘Next’. If you let the trial 
period expire without paying for the full version, the program will 
not be able to lock new folders; however, it will still be able to 
unlock protected folders on your computer. ■

5 Protect folders in Windows Explorer
You don’t have to open up the program first to use Folder 

Password Expert’s features. Right-click the folder in the right-hand 
pane of Windows Explorer and select ‘Lock folder’ from the 
pop-up menu. To complete the process, enter your chosen 
password. Unlocking the folder is also easy: double-click it in the 
right pane of Windows Explorer and enter the password.

3 Verify locked folder
Let’s test what happens when you lock a folder. Navigate to 

the folder in Windows Explorer and you will see that it now has a 
little red stop sign next to it, indicating it’s locked. Double-click 
the folder to open it. Folder Password Expert will be launched and 
you’ll need to enter your password for access. The password hint 
(if you provided one) can be acquired by clicking ‘Get a hint…’

6 Quick access
Folder Password Expert helpfully adds a context menu to 

the Start menu entry. An arrow points to the right showing your 
recent protected files. Here you can permanently pin folders to 
the Recent list, unlock them or remove them entirely. If you 
manually pin the Folder Password Expert start menu icon to the 
Taskbar you still get the Recent menu when you right-click.

4 Unlock folders
Open up Folder Password Expert again, but this time 

choose ‘Unlock folders’ and on the next screen select the folder 
from the list (if you have more than one locked folder) and click 
‘Next’. Tap in your password on the next screen. The next screen 
will say you can now open the folder normally. Remember to go 
back and lock it again if you want to keep it secure.

Explore 
Protect your folders
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Learn how to…
Lock down 
Windows 10

“Windows 10 is great, but there 
are a few settings you should 
check to keep information private”

indows 10 is currently being 
rolled out to Windows 7 and 
Windows 8.1 users who can 

upgrade to Microsoft’s latest and 
greatest operating system for free. 
While it’s great to be offered the 
latest software without paying, there 
are a few privacy settings that you 
should tweak after you’ve upgraded. 
There’s nothing sinister here, but by 
installing Windows 10, a number of 
default settings are enabled that 
gives Microsoft data on how you use 
your PC. While cynics might say this is 
the price we pay for getting a free 
update, it’s easy to change the 
settings so you only share the 
information you want to – and if 
you don’t want to share anything, 
we’ll show you the changes you 
need to make. It doesn’t take long to 
tweak Windows 10’s privacy settings, 
and once you’re done, you can enjoy 
the new operating system without 
any worry.

1 Start at the beginning
During the installation of Windows 10 you can set many 

privacy settings before it’s up and running. It will ask if you want 
to use ‘Express Settings’ and while this is tempting, click ‘Custom 
Settings’ to turn them off – we’ll explain more in the next few 
steps. This is the best way to stay secure, but if you did choose 
Express Settings, don’t worry, you can change that later.

2 Open Privacy Settings
If you didn’t tweak privacy settings during installation you 

can do so by opening up ‘Privacy Settings’ from the Start menu and 
selecting ‘Settings’. In the window, click ‘Privacy’ and you’ll see a list 
of options, along with sliders that let you turn the options on and 
off. The first option to use Advertising ID should be switched off. 
SmartScreen Filter can be left on, as it will keep your PC secure.

Step-by-step Configure Windows 10 privacy settings

Your guide Matt Hanson says…

GenerAL PrIvAcy
Click here to see 
general privacy 
settings. From here 
you can change how 
Windows 10 tracks you 
for advertising, or how 
it views the way you 
type and write. 

LocAtIon
Click here to change how 
Windows 10 monitors your 
location. If you regularly use 
apps such as Maps and 
Weather, you can still use 
them with location tracking 
off, though you will need to 
enter in the postcode of your 
location first. 

SPeech, InkInG & tyPInG
This is where the settings for 
configuring how the virtual 
assistant Cortana learns about how 
you use your computer. It can be a 
useful feature, but if you’re 
concerned for your privacy, you can 
turn it off here. 

w
Anyone can do it 
Straightforward
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance…
SkILL LeveL

tIme tAken

SuItAbLe for

10 minutes
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3 General Privacy
The rest of the settings in the General Privacy screen can be 

turned off. However, if you don’t mind Microsoft seeing 
(anonymous) data about how you write on your touchscreen, you 
can leave that setting on, as it will help Microsoft improve the 
accuracy of its handwriting apps. Once you’re happy with the 
selections you’ve made, we can move on to the next set of options.

4 Location settings
The Location settings is worth visiting. Some apps, such as 

Maps and Weather, use your location in a helpful way – showing 
you the local area or telling you the weather forecast for where 
you are, for instance. That’s why you shouldn’t turn off location 
information completely, but choose which apps are allowed to 
access the data. Just scroll down and select the approved apps.

Jargon buster!
 Windows Apps

Windows Apps are 
programs that you 
download and install 
from the Windows 
Store. Microsoft also 
includes a number of 
apps preinstalled 
with Windows 10.

 Advertising ID
An anonymous ID 
Microsoft applies to 
your account that 
lets it see what kind 
of things you are 
interested in, and 
provides target  
ads that might be  
of interest.

 cortana
Cortana is Windows 
10’s virtual assistant 
who helps with 
day-to-day tasks – 
just speak into your 
microphone and say 
‘Hey Cortana’ to 
start it up.

toGGLeS
Click these toggles to turn a 
setting on or off. Most settings 
are fine to turn off, but some 
might make Windows apps 
work incorrectly. 

mAnAGe mIcroSoft 
ADvertISInG
Click this link to be taken to a 
website where you can choose 
further features to turn off in 
regards to targeted advertising 
from Microsoft. 

fInD A SettInG
This search box is 
useful if you are 
faced with a page 
full of settings and 
you want to find 
something specific. 
Just type in what 
you’re searching for, 
and Windows will 
take you there. 

Matt’s best tip!
Rather than turning off 
certain settings completely, it ’s 
sometimes better to go through 
and allow apps access to your 
information on a case-by-case 
basis. It means you have 
complete control over who or 
what sees your information .
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9 Disable Wi-Fi Sense
One of the most controversial features of Windows 10 is 

Wi-Fi Sense, which shares your Wi-Fi settings with contacts 
automatically. This has security implications so we’d recommend 
turning it off. To do so, go back to the main Settings window, 
select ‘Network & Internet’ then ‘Wi-Fi’. Click on ‘Manage Wi-Fi 
Settings’ and under ‘Wi-Fi Sense’ turn off everything.

7 Other privacy settings
The next window asks if you want to share your account 

info with apps. Many apps from the Windows Store need this 
information to work, so you might want to keep this turned on. 
You can also select whether or not to share your contacts, 
calendar or text messages from the windows below. With these 
settings you can choose which apps have access to your info.

5  Camera and Microphone
The next two windows will let you change how Windows 10 

uses your webcam and microphone – if you have one installed. If 
you use services like Skype to video call people you probably 
don’t want to block access to your camera or microphone, so it’s a 
good idea to approve apps that can access your camera and 
microphone on a case-by-case basis – as in the previous step.

10 Use a local account
If you want even more privacy you can create a local 

account and use it with Windows 10, rather than a Microsoft 
account. This limits the functionality of some apps, but will make 
sure your privacy is under control. To switch to a local account go 
to the main Settings window and select ‘Accounts’. Click ‘Sign in 
with a local account instead’ and enter your password. ■

8  Other devices
Not only does Windows 10 share your info with Microsoft, it 

can also share it with other devices connected to your Wi-Fi 
network or plugged into your computer. This makes using your 
machine with other devices easy and convenient. However, you’ll 
want to check the ‘Other devices’ settings to make sure you know 
which devices you’re sharing information with.

6 Keep Cortana from peeking
cortana acts like a virtual assistant and carries out web and 

file searches using your voice. However, this does mean it (and 
therefore, Microsoft) is always keeping an ear out for what you 
say. To improve Cortana, data about the files you have on your PC 
and the web searches you do are also shared. Turn this off in 
‘Speech, inking & typing’ and select ‘Stop getting to know me’.
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Learn how to…
Discover music  
in Windows 10

“Find, stream and play music  
from your own collection with  
the new Groove Music app”

usic fans will be interested 
to hear that you don’t need 
a Spotify account to enjoy 

music streams in Windows. 
The Groove Music app pairs 

with your OneDrive account to 
offer you the option of streaming 
music from your collection across 
all the devices you own. It also lets 
you browse and play any music you 
have physically stored on your PC 
too. Search for any artist, song or 
full album and instantly play what 
you want. You can even create and 
save playlists for easy access to the 
songs you love.

Groove Music brings you all the 
music you love in one simple app: 
add a Music Pass (£8.99 per month) 
and you can stream millions of 
songs to your PC, and you can also 
buy music outright from the 
Windows Store, too.

1 Launch the Groove Music app
First of all, click the ‘Start’ button and the select ‘Groove 

Music’ from the ‘Play and Explore’ section in the right-hand  
pane. When the app launches for the first time it’ll set to work 
finding and adding music stored in your Music Library – if  
your music is stored elsewhere, then you can jump straight  
to step seven.

2 Find and play a track
In the left-hand column you’ll see the main navigation, and 

at the top is the main search field. Just type the name of an artist 
or album and you’ll see suggestions appear. Press [Enter] to run 
the search, or choose from the list. You might be presented with 
several possible results, so choose one to see the artist’s 
discography, with their most recent albums listed first.

Step-by-step Get going with Groove Music

Your guide Nick Peers  says…

Search
Start by exploring an 
artist you know by 
typing their name 
in here. The app 
suggests artists held  
in its database as 
you type.

collection
Browse your 
collection here by 
artist, album or 
song. This includes 
all ripped and 
purchased music as 
well as available 
streams through 
your OneDrive 
storage or a 
premium Groove 
Music Pass.

PlaYliStS
Think of playlists as 
your chance to build 
the ultimate mix CD 
or cassette – you can 
add entire albums or 
individual tracks,  
plus reorder the 
running order using  
drag and drop.

M
Anyone can do it 
Straightforward
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

at a glance…
SKill leVel

time taKen

Suitable for

1hour
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3 Now Playing
Switch to the ‘Now Playing’ view and a list of all queued 

tracks will appear underneath an enlarged view of the currently 
selected track’s album cover. The floppy disk icon to the right of 
the track info allows you to convert a Now Playing list into a full 
blown playlist; you’ll also see an option to switch to full-screen 
view – move the mouse to reveal playback controls.

4 Using playlists
Digital jukeboxes (and iTunes in particular) have made 

playlists essential for music lovers. They work here in the way you 
would expect. Select ‘New playlist’ from the left-hand side and 
then give the playlist a name. To add a song to your new playlist, 
return to the list of tracks by an artist, select a track and hit the ‘+’ 
button, then choose your playlist from the drop-down list.

main VieW
This view changes depending on 
what section you’re in – here you 
can see how things look when 
browsing by a specific playlist. 
Right-click a track to view available 
options, or double-click it to play.

SettinGS
Click this button to 
tweak settings, such 
as where to find 
music, or cleaning 
up duplicate tracks 
in your collection.

PlaYbacK controlS
Wherever you are in Groove 
Music, this bar at the bottom 
allows you to control playback, 
pausing or skipping tracks to 
switching shuffle and 
repeating on and off.

Explore 
Discover music in Windows 10
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9 Go Premium
As with Spotify, not all of the app’s features are available 

in the free version. Sign up for a Groove Music Pass and you’ll get 
unlimited ad-free listening on all your Windows devices. You can 
also download music for offline listening and create playlists that 
automatically sync across all your devices. There’s a 30-day free 
trial available if you want to try it out before buying. 

7 Add folders to collection
If Music doesn’t grab all your collection, or you wish to add 

a separate folder of music for it to monitor, click the ‘Settings’ 
button next to your username in the left-hand pane and click 
‘Choose where we look for music on this PC’.  Click the ‘Add’ 
button to browse for your new folder and, once it’s selected and 
in the list, click ‘Done’.

5  Build playlists quickly
A quick way to add tracks to your playlist is to switch to 

‘Songs’ view. Click ‘Select’ at the top of the song list and then scroll 
through it, ticking all the tracks you’d like to add. Once done, click 
the ‘Add to’ button at the bottom of the screen and choose which 
playlist to add the songs to. Alternatively, select ‘Now playing’ for 
immediate listening, or ‘New playlist’ to create a playlist. 

10 Purchase new music
If you’d rather own music than simply rent it, click ‘Get music 

in Store’ to switch to the Windows Store’s music section. Search or 
browse for new music – you can purchase individual tracks or 
entire albums, which are then downloaded to your collection (and 
made available on your other devices too). When you’re done 
browsing, click ‘Your music library’ to return to your library. ■

8 Access OneDrive music
Open your OneDrive folder where you should find a Music 

folder. Upload your digital music – WMA, MP3 and M4A/AAC are 
all supported – to this folder and you can stream it through 
Groove Music even if the files aren’t physically on your PC. 
Purchase a Groove Music Pass and you’ll be given an extra  
100GB of storage for the duration of your subscription too.

6 Pin to Start
Groove Music lets you place your favourite tracks, artists, 

albums and playlists as tiles on the Start menu, allowing you to 
play them with a single click or tap. Just click ‘Pin to start’ next to 
an artist name, or look for it under ‘More’ when browsing albums; 
individual songs can be added by right-clicking the track in 
question and choosing ‘Pin to start’. 
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M
icrosoft Edge is unusual 
– it’s a brand-new default 
browser for Windows 10 
and for Windows Phone. 
As such, a lot of attention 
has been placed upon it, 

but why are we so interested in browsers? 
The answer lies in how we now use the 
web. So many apps are now available 
online and we’re moving online with them. 
Chances are you use a web-based email 
account. Even if you use a desktop email 
program such as Windows Mail, you’ll still 
be able to access your email account 
through the web. And likewise, many of us 
are now editing documents online, writing 
notes – even editing images. All functions 
that were, a few years ago, the preserve of 
desktop software. So when a new browser 
appears, there’s great interest in how it 
will perform. 

Close to the Edge 
Speed is a big factor with browsers,  
and it’s one of the biggest reasons why 
Microsoft Edge is getting a lot of attention 
– and it’s also the main reason why you’ll 
like it when you use it. Even when 
Microsoft Edge was first unveiled in a 
developmental form back in January, it 
was clear it would be fast, beating Google 
Chrome and Mozilla Firefox for sheer 
speed of rendering simple web pages. 
That doesn’t necessarily mean this will 
always be the case; Microsoft hasn’t yet 
added Extensions to Microsoft Edge  
(the ability to add third-party applications 
to your browser); extras like that can have 
an impact on the speed of the browser. 

The main reason for the fast 
performance is that Microsoft has 
developed a new ‘layout engine’ for 
processing (or ‘rendering’) web pages 
called EdgeHTML. One reason for its 
speed is that it’s focused purely on 
modern web page standards rather than 
support for older pages. That means that 
some old websites won’t work properly. 
We’ll explain more on that shortly, but the 
benefit is that the engine powering the 

browser can be faster. Microsoft Edge also 
matches the speedy Google Chrome  
for JavaScript performance – JavaScript is 
the programming language behind many 
dynamic web pages. 

As well as Extensions, there are several 
other things missing from the version 
of Edge that shipped with Windows 10. 
However, you can now rearrange your 
Favourites, as well as add different search 
providers to Edge, for example – features 
that weren’t available at first. Microsoft 
has promised further development on 
Edge over the coming months. 

Initially, when we tried out an early 
version of Microsoft Edge back in January  
(it was originally codenamed Project 
Spartan), it was basically unusable as a 
browser because so many features hadn’t 
been finished and some web pages didn’t 
work properly. Now it’s quite different and  
it’s perfectly possible to use as a day-to-
day browser. We’ve done it and we like it. 
Microsoft has a bit of a problem with 
Internet Explorer. However much it wants  
to, it can’t consign it to the Recycle Bin for 

good. That’s because a lot of businesses 
have long-used software that depends on 
Internet Explorer. It’s been a default 
browser for a huge number of systems. 
While other browsers can be used, 
specifying a particular version of IE within 
software requirements provides a standard 
browser – often provided with Windows 
itself – that can be rolled out across a 
business. If you’ve been for an 
appointment at your bank recently, 
chances are they were using IE. This long 
dependence may be changing, but it’s due 
in no small part to Internet Explorer being 
a constant running throughout the last 
two decades of Windows – it first debuted 
as part of an add-on pack for Windows 95.

And for that reason alone, Microsoft 
has also included Internet Explorer with 
every version of Windows 10. So while 
Edge is the browser that’s front and 
centre, Internet Explorer is still there if 
you need it – you can simply search for it 
from the Taskbar. 

Another reason for continuing to include 
it is that, as we previously mentioned, 

Microsoft Edge is Windows 10’s brand new browser. 
We explain why it’s here and how to use it

Welcome to 
Microsoft Edge

Microsoft Edge carries on Internet Explorer’s use of a stylised ‘e’ as its logo
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Microsoft Edge

Annotations can easily be shared to OneNote, now a new-style Windows app in Windows 10 

As well as its 
speed, Edge 
also brings 
innovative 
new features 
to the table

Microsoft Edge has been designed with 
the future in mind. It won’t properly load 
websites that use outdated web tech. 
Internet Explorer is the fallback if you 
come across a page like this; if there’s a 
page Edge can’t load properly, you’ll be 
offered the chance to load it in IE instead. 

This shouldn’t be seen as a criticism. 
Edge is a clean break from older web 
technologies and is a leaner browser for 
it. As well as its speed, Edge also brings 
some innovative new features to the 
table. One of these is the ability to 
annotate web pages. While third-party 
apps have enabled this before, it’s 
unusual to see it in a browser. You can 
highlight certain paragraphs just as you 
would with a highlighter pen. Then you 
can type (or write!) notes on the page. 
Finally, you can export your creation to 
OneNote so you can save the note for 
posterity and share it. It’s just another 
indication of the different ways we’re 

now working with the web – because 
more and more of us are working on 
content within the confines of the 
browser, Microsoft thinks it could 
give Edge the jump on rivals. And, by 
association, get more people using 
OneNote, which also comes as a 
Windows Store app within Windows 10. 
Your Notes are always backed up and 
synchronised across your Windows 
devices. There’s even a shortcut to 
create a Note from the Windows 10 
Action Centre. 

Microsoft hopes Edge will become a 
default for many users of Windows, and 
despite temptation to the contrary, it’s 
even kept a similar ‘e’ logo to make things 
easy for users familiar with IE. But in every 
other way, Edge is a completely new 
experience and is much better for it. And 
even though it’s already a good experience 
in use, there are still plenty of new features 
to come, too. 

The default new tab page shows you your most visited sites, but you can have news stories via MSN

As well as the ‘light’ default theme 
of Microsoft Edge, you can 
alternatively paint it black 
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1 Welcome to the Edge
When you first launch Edge, you’ll notice it’s very cleanly 

designed. As with Windows 8, Windows 10 uses ‘flat’ design.  
It’s a minimalistic approach, but the idea is that the buttons  
and commands come to the fore, rather than the design of the 
application itself. So Edge simply has the main controls on the  
top left and more complex, optional items on the top right.

2 Add a Favourite
Adding a Favourite is simple; just click the ‘Star’ icon. You will 

then get a pop-up. Click ‘Add’ or edit the entry, giving it a new 
name. You can also add it to a folder. One of the folders is called 
‘Favourites Bar’; this enables you to display your main Favourites 
underneath the address bar. To enable this feature, go to ‘Settings’, 
via the main menu, and toggle ‘Favourites Bar’ on.

Step-by-step Getting started with Edge

Learn how to…
Browse with 
Microsoft Edge

“Let’s take a look around some  
of the exciting features of Edge 
Microsoft’s latest browser”

dge has a significant 
number of new features, 
so it makes perfect sense 

to take you through them. While 
it’s designed differently from other 
browsers, such as Internet Explorer 
and Google Chrome, the basic user 
interface doesn’t stray hugely from 
accepted browser wisdom in terms 
of the placement of key controls. 
Seasoned Internet Explorer users will 
also notice that the Favourites/History 
and Download sidebar is very 
familiar, though now with the 
addition of the Reading List. We can 
only assume that Microsoft thinks the 
formula works and that it wants to 
ensure users migrating from IE can 
take to Edge straight away. As before, 
you can pin this sidebar so that it’s 
always there, should you so wish. We 
haven’t pinned it in the examples on 
these pages. 

Your guide Dan Grabham says…

STANdArd cONTrOlS
Many of Edge’s basic 
controls will be familiar, 
with the forward/back/
refresh panel fairly 
standard from other 
browsers. The security 
padlock also resides in 
the same place  
as other browsers.  

E
Anyone can do it 
Straightforward
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance…
SKIll lEVEl

TIME TAKEN

SuITABlE fOr

30 minutes
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3 Your Reading List
When you add a Favourite, you also have the option to  

add the page to your Reading List. Think of this as a place to store 
articles you want to read later. Save to your Reading List just as 
you add a page to Favourites, selecting ‘Reading List’ at the top of 
the pop-up box instead. To access Reading List, click the icon to 
launch the sidebar.

4 Check your History and Favourites
Within the sidebar, you can cycle through your Reading List, 

Favourites, Downloads and History; use the icons at the top to 
select what you need. There’s also a pin to keep the sidebar open. 
Here we’re looking at our History. You can select any page or clear 
them. If you don’t want to add sites to History, select ‘InPrivate’ 
browsing from the main menu. This will open a new window.

AdVANcEd SETTINgS
As you can see here, the 
basic Settings menu 
isn’t that comprehensive 
– an Advanced Settings 
button takes you 
deeper and enables you 
to fine-tune more of the 
Microsoft Edge features. 

rEAdINg VIEW 
cONTrOlS
The Reading View can 
be fine-tuned 
depending on your 
requirements – you can 
change the font size 
used, as well as the 
colour of the 
background.   

NOTES ANd ShArINg
These controls enable 
you to launch Edge’s 
Notes mode (so you 
can annotate web 
pages). The Share 
button enables you to 
share any web pages 
with compatible 
Windows Apps, like 
Mail and OneNote.   

ThE fAMIlIAr SIdEBAr
When you click the star to ‘Favourite’ 
a page, you’re now also offered the 
ability to add to your Reading List. 
The = icon launches the sidebar 
featuring your Reading List, 
Favourites, Downloads and History.   
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9 Reading mode
If you go to read an article on the web (rather than a 

homepage, such as bbc.co.uk), the book icon next to the address 
bar will become active (it goes black rather than grey). Clicking it 
puts you into ‘Reading Mode’, which offers a clean interface. You 
can fine-tune how it looks in Settings – here we’ve selected ‘Dark’ 
for the background. You can also change the size of the text.

7 Edge’s main menu
Open the main menu via the ellipsis (…) icon in the top 

right. From here you can open a new window or an InPrivate 
window, as well as zoom into the current page. You can also opt 
to pin a particular web page to your Start menu as a tile. From 
here, you can access the Settings, plus perform other functions 
such as ‘Print’ and ‘Find a word or phrase’ in the open web page.

5  Editing Favourites
You can drag and rearrange Favourites within the Favourites 

area of the sidebar. Here, we’ve displayed the Favourites Bar via 
the ‘main menu > Settings’ and we’ve gone into the folder within 
Favourites that controls that. Right-click on anything in Favourites 
to bring up options such as opening the page in a new tab, 
creating a new folder or renaming the item.

10 In-depth Settings
Within ‘Settings’ you’ll see ‘Advanced Settings’. These cover 

things such as your browser cookies (data that sites leave on your 
PC to keep track of you) and other security settings. You’ll never 
need to worry about most of these, but it’s great that you can take 
control if need be! You can also change search provider and 
choose if you want Edge to help with search suggestions. ■

8  Open in Internet Explorer
If pages don’t display, there is the option of opening them 

in Internet Explorer. You can do this manually, using the ‘Open 
with Internet Explorer’ on the main menu. But if you open a page 
that uses old web technologies, this prompt will urge you to open 
it in IE instead. The example here is Sky Go TV on demand. It uses 
the Silverlight video player, which is no longer in development.

6 Annotate pages
One of Edge’s best features is the ability to annotate web 

pages. You can switch into this mode using the button in the 
top-right of the main window. You have editing controls on the 
left, while you can save, share or exit on the right. The controls 
include a pen, a highlighter, an erase function, an annotation 
feature and a copy tool that lets you copy an area of a web page.
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Learn how to…

“Tap on the Store tile on the taskbar to browse, install  
and update apps on your Windows 10 PC or tablet”

Your guide Nick Peers says…

Use the Windows Store

Browse apps
The front of the Store is 
designed to bring more 
relevant and popular apps and 
games front and centre. The 
first screen you see shows you 
various picks and suggestions 
for great apps, along with 
category shortcuts, but you 
can scroll down to reveal the 
top apps in various categories, 
including free (always a 
winner), new and rising apps. 
Keep scrolling to access games.

The power 
of search
It’s easy to find an app you’ve 
heard about. Just tap or click, 
in the search bar in the top 
right-hand corner of the Store, 
type in the name of the app 
you’re looking for and hit 
[Enter] to view suggested 
results. Use the ‘Refine’ 
categories on the left to 
narrow your search by  
content type, or click ‘Show all’ 
next to Apps or Games to  
view all matches and access 
further filters to help refine  
the results further.
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Installing a  
new app
Select an app to view its details 
and install it. You’re rewarded 
with larger screenshots and 
easier access to ratings and 
reviews (just scroll down).  
Keep scrolling and you’ll  
also find handy links to other 
titles by the same publisher, as 
well as a list of apps compiled  
by Bing that may be of interest. 
If the app is free then you can 
install straight away, if it’s 
paid-for then you need to  
hit the ‘Buy’ button.

Updates made easy
Windows can be set to update your apps 
automatically as new versions become available.  
If you don’t like this behaviour, you can switch it  
off by clicking your user avatar and choosing 
‘Settings’, then flick the appropriate switch to ‘Off’. 
To manually check for updates, click your avatar. 
choose 'Downloads' and then click the 'Check for 
Updates' button. n
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Use Microsoft’s cloud storage system to access your files wherever you are

icrosoft’s online storage 
offering, OneDrive, has joined 
the likes of Dropbox, Google 
Drive and BT Cloud in the 
scramble to get your files 
backed up in the cloud (that 
nebulous term for banks of 
storage racks humming away 

in a data centre... somewhere). OneDrive has 
been through a couple of different 
incarnations since its launch in 2007. 
You might remember it as SkyDrive, which 
was its codename before it became available 
for beta-testing as Windows Live Folders. It 
became Windows Live SkyDrive very shortly 
after launch. The ‘Windows Live‘ part of the 
name was quietly dropped, and SkyDrive 
rumbled on through the launches of Windows 
7 and 8 until 2013, when a case in the High 
Court in London determined that the name 
infringed BSkyB’s ‘Sky’ trademark. From these 
Murdoch-stoked ashes rose OneDrive, and 
that moniker is the one you’ll find today in 
Windows 10.

Cloud storage is important for anyone who 
wants an off-site backup of important 
information they can’t afford to lose. This 
might be your accounts, irreplaceable 
photographs or home movies. OneDrive 
protects you against data loss by saving 
multiple copies across its servers, so if one fails 
there’s always another to take its place. Your 
data is hidden behind a password and 
two-step authorisation system (if you enable 
it) so only you can access it, and thanks to 
mobile apps, everything stored there can be 
at your fingertips wherever you are, on any 
device. You can think of OneDrive as an extra 
15GB of storage for your smartphone; the files 
from your PC can be delivered over its data 
connection with a few taps.

If you’re a Windows 10 user, you’ll find 
OneDrive is built in, and because you use a 
Microsoft account to log into your computer it 
will use OneDrive to sync your files and 
settings across multiple PCs. If you’re using a 
version of Windows older than 8.1, there’s a 
desktop app that offers file syncing.

one 
drive

take windows 10 
into the cloud 
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or Windows 10 users, OneDrive  
is transparent as long as you’re 
signed in with a Microsoft 
Account. Running 
automatically in the 

background, backing up your documents 
and settings, you may never even know it’s 
there. Bring up the Start menu, and start 
typing ‘OneD…’ by the time you’ve got 
that far through its name, Windows will 
have found its sole option – opening the 
OneDrive folder. OneDrive options are 
spread around Windows 10 rather than 
existing as a dedicated app, but pay a visit 
to the System Tray, and you’ll find a 
OneDrive icon there that allows access to 
settings and help if you right-click it.

Click on ‘OneDrive Storage Space’, 
and you’ll open a web page dedicated to 
your OneDrive. First up is your free space. 
You get 15GB by default, although there 
are ways to expand this. That’s quite a lot of 
storage though, as you’re only going to use 
it for documents and data rather than for 
installing programs or operating systems. 

There aren’t many options on the web 
page other than the prominent ‘Buy more 
storage’ button. Saving documents to 
OneDrive is enabled by default in recent 
version of Office, but you may still want to 
move your Documents and Pictures 
folders inside the OneDrive folder so that 

onedrive in windows 10

all your documents go into the cloud as 
well as being stored locally on your hard 
drive. If you’ve got more than one 
Windows PC, logging into them all with 
the same account means your documents 
will be automatically synced between the 
computers, so you’ll never need to run 
upstairs to switch on the desktop 
computer to find a spreadsheet when you 
could be sitting in the garden with your 
laptop instead.

PC settings can also be synced between 
computers, including things like desktop 

icons and wallpaper, making it feel like all 
your computers are one computer and 
removing the need to make the same 
change to all your systems.

Click ‘Accounts’ in Windows’ Settings 
app to find the sync settings. If you want 
your PCs to feel familiar, with 
no differences in wallpaper, Start screens 
or even elements such as browser and 
mouse acceleration settings, then turn  
all these options to ‘On’. This also means 
you can save all your PC settings to 
OneDrive without having them synced 
across multiple computers. You can 
restore the settings to your PC if you  
ever need to replace its hard drive, or 
reinstall the operating system for another 
reason, making your ‘new’ computer just 
like your old one.

You can also automatically upload your 
pictures from your PC hard drive to 
OneDrive, and 15GB can hold a lot of 
photos. Make sure syncing of the Pictures 
folder is turned on in OneDrive settings, 
then you can forget about it. Every time 
you save a new photograph to your PC, it 
will appear online a little later, depending 
on the speed of your internet connection. 
Once it’s there, it will also be available to 
any other PCs or devices you’re logged into 
with the same Microsoft account.

Photo uploading also works the other 
way – images taken on your phone can be 
synced to your desktop PC without having 
to connect the two with a cable. This is 
where the final option in Settings comes 
into play: Metered Connections.

If you’re using Windows 10 on a tablet 
or laptop with a SIM card slot, you might 
not want uploaded photos running up 
your phone bill. Metered Connections gives 
you options for controlling this, allowing 
your device to synchronise settings, for 
example, while turning off photo or movie 
uploading while you’re using mobile data.

SEARCHING WINDOWS In Windows 10, it’s easier than ever to find what you’re after

Microsoft has made the cloud an integral part of its latest OS

Microsoft hasn’t forgotten about 
the legions of users Windows 7 still 
commands. While the venerable 
operating system doesn’t have 
the full OneDrive functionality of 
Windows 10, there’s still an app you 
can download to gain at least some 
of the cloud backup features.

To get started with OneDrive, 
point your Windows 7 PC’s web 
browser to www.onedrive.com, 
where you can either sign in with an 
existing account or create a new one. 
You don’t have to do that yet though 
– just click ‘Get OneDrive on your 
devices’, then ‘Download OneDrive 
for Windows’ on the left-hand side. 

A setup file will download, which 
you can double-click to run, and the 
app will install. You’ll need to 
provide the app with account details 
and choose a location for the 
OneDrive folder on your hard drive. 
Any files you copy into this OneDrive 

folder will be mirrored on the 
OneDrive website, and any you 
upload from mobile devices will 
appear here once synchronisation 
has taken place. 

If you’ve got a lot of data stored 
in the cloud that you don’t want to 
appear on your hard drive, you can 
use OneDrive’s selective sync feature 
to limit what gets downloaded. 
Right-click the OneDrive icon in 
the notifications area, then select 
‘Settings > Choose Folder > Choose 
Folders’. Here you can decide which 
folders stay in the cloud, and which 
ones are synced for you to use.

What about WindoWs 7?

F

68  |    |  November 2015



ince 2010, Microsoft has 
offered a cut-down version 
of its Office suite that runs 
in your web browser and 
saves its files to OneDrive. 

Office Online is completely free to use, 
and for general word processing and light 
spreadsheet use, it’s the only office suite 
you’ll need (as long as you’re connected 
to the internet).

To use Office Online, head to www.
office.live.com and click the tile for the 
application you want to use. You might 
have to sign in with your Microsoft 
account if you haven’t already done so. 
You’ll be offered the choice between 
templates or a blank document, just as 
you would in the desktop version of 
Office, and the apps behave very much 
like their full-fat cousins – the ones 
Microsoft would like you to pay for.

Office Online documents are saved in 
the Documents part of your OneDrive 
folder as ordinary files (.docx, .xslx, etc), 
as their desktop equivalents would. 

office online Get free space 
from alternative 
cloud services

BOx Box has been around since 
2005 and currently offers 10GB 
with a free personal account. The 

size of each file, however, is limited to 
250MB. This makes it less useful for 
archiving movie files, which can be very 
large. In comparison, OneDrive and 
Dropbox allow files up to 10GB each. You 
can expand Box to unlimited storage 
with a paid-for enterprise account.

AMAzOn ClOuD DRIve
Amazon offers 5GB for free and 
paid plans ranging from 20GB 

for £6 a year up to a whopping 1TB for 
£320 a year. Geared more toward photo 
and video backup rather than general 
file storage, Amazon offers apps for 
mobile devices, but documents other 
than photos and videos won’t appear 
on mobiles even if they’re in your drive. 
Only eight devices are allowed access to 
your account at any one time.

It’s Microsoft Office, in your web browser

OFFICE ONlINE Microsoft’ programs are also available as free online apps

iClOuD Apple recently expanded 
its online storage offering, with 5GB 
available for free and 20GB for 79p a 

month. If you’re an iPhone user you’ll 
already have an iCloud account attached 
to your Apple ID, but iCloud doesn’t work 
like other cloud storage offerings. There’s 
no simple folder syncing here, even 
through the Windows app.

This means you can write up a 
proposal and send it by email as a 
simple attachment to be opened on 
the recipient’s PC. And while it’s not 
made very clear, you can rename a  
file by clicking its name on the 
browser app’s blue header bar, so  
you don’t end up with lots of files  
just called ‘Document’.

There’s something else OneDrive 
can do that’s a little more clever. You 
can use it to embed documents into 
websites, making it easy to display 
information that can be edited in 
Office Online rather than tinkering 
with HTML. 

From your Office Online document, 
select ‘File’ (that’s Office Online’s File 
menu, not your web browser’s) then 
‘Share’. Hit the blue ‘Generate’ button, 
and you’ll be prompted to select a 
width for your document in pixels. 
When you’re happy, copy the code 
from the bottom of the window, and 
paste it into a page of your website. 

S
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f This Then That (www.ifttt.
com) is an extremely handy 
online service that can 
automate the interactions 
between other online services. 

This sounds like madness, but a simpler way 
of thinking about it is that, if you want, all the 
pictures you’re tagged in on Facebook 
can be saved directly to OneDrive. 

The service keeps running until 
you tell it to stop, so any pictures 
you’re tagged in from then on will be saved 
to OneDrive too, and from there appear on 
your hard drive.

IFTTT uses ‘recipes’ to do its work, and at 
the time of writing there were 643 available 
that make use of OneDrive, from saving all 
your Instagram photos to it, to Gmail 

attachments (useful for immediately 
opening Office documents in Office 
Online), to Bing’s image of the day. You  
can even save tracks from Soundcloud 
direct to OneDrive, if they’re available for 
download.If you’re looking for a really 

Get more onedrive storaGe

There’s an easy way to get an extra 
15GB of OneDrive storage. Simply 
upload your camera roll from your 
phone to OneDrive, using the free 
OneDrive app, and you will be 
rewarded with an extra 15GB of free 
space, for a total of 30GB.

If you don’t want to do this then 
referring your friends is another free 
way to get extra storage. Go to www.
onedrive.com, log in and click the ‘Get 
more storage’ link at the bottom of the 
left-hand sidebar. Click Get Free 
Storage. You can earn a 500MB bounty 
for anyone who signs up for the service 
from one of your referral links – it’s well 
worth having even though it might 
take a lot of friends to match the 15GB 
of free capacity. 

The only way to access truly huge 
amounts of storage, enough to back 
up whole hard drives’ worth of data,  
is to pay for it, and this is likely to be 
the choice of the professional who 
can’t risk losing images, movies or 
audio data.

extra storage can be bought from 
the OneDrive website, or through the 
OneDrive storage space app. either 
way, a terabyte of space will set you 
back £7.99 a month. This includes a 
subscription to Office 365 for five users 
– each of whom gets the full 1TB. 

There are cheaper options available. 
£1.99 or £3.99 a month gets you 100GB 
or 200GB of storage space respectively 
(in addition to your free 15GB), but 
without the Office subscription.

ifttt and 
onedrive
Automate your cloud backups

SeleCTIve SYnC 
Windows 10 drops the file 
placeholders seen in 

Windows 8, as many users found 
them confusing. Instead, there’s 
now a Dropbox-like selective sync 
system that lets you choose 
exactly what data ends up in the 
cloud. Right-click the OneDrive icon in the system tray and 
choose ‘Settings’, then click the ‘Choose Folders’ button on 
the ‘Choose Folders’ tab. Tick the folders you want to back up.

veRSIOnInG
Shared documents are 
vulnerable to being 

overwritten, but OneDrive allows 
you to roll a file back to an earlier 
version, potentially saving hours 
of work. Head to www.onedrive.
com and log in. Find the 
document in question, right-click it and select ‘Version history’. 
The document will open in a new browser tab, with a sidebar 
that lets you see earlier saved versions of the file. 

tips and tricks

secure off-site backup plan, you could use 
IFTTT to synchronise the contents of your 
OneDrive with another cloud storage 
system, such as Dropbox, mirroring your 
files between the two and knowing 
nothing will be lost.

FINAl FRONtIER It’s easy to get more space completely free

AutOMAtED 
Save pictures 

straight to 
OneDrive

I



ENtERpRISE OneDrive for Business offers many tools and services not included in the home version

neDrive for Business can  
be seen as a company’s 
fileserver, but online and 
accessible from anywhere. 
This enterprise version of 

OneDrive is fundamentally different to 
the consumer edition we’ve discussed  
in the rest of this feature, though. 
Although they’re both available under  
the same OneDrive banner, OneDrive for 
Business runs on Microsoft’s older 
Sharepoint application framework, first 
launched in 2001.

This means that if you use OneDrive 
for Business, you won’t be able to use  
the same username and password to  
log into a standard OneDrive account.  
The two services have different 
development histories and different  
ways of working. 

In general use, OneDrive for Business 
looks and acts just like the consumer 
version, with integration into Office 
Online and the desktop Office apps 
available as part of Office 365. Teams can 
collaborate on documents, with 
OneDrive for Business keeping files up to 
date across computers that aren’t 
necessarily all in the same building or 
connected to the same network, as long 
as they’re online. There’s protection 
against data loss built in, too.

If you can’t connect to the internet, 
OneDrive for business will sync your 
documents as soon as you reestablish a  
net connection.

OneDrive for Business is a powerful 
aspect of the service, which comes with a 
monthly fee for every user, but offers 1TB  
of storage for each one.

onedrive for 
business
Those about to work, we salute you

ReCYCle BIn
If you’ve deleted something 
from OneDrive by mistake, 
head to www.onedrive.com 

and log in. On the left, near the 
bottom of the sidebar, you’ll see a 
link to the Recycle Bin, which 
behaves much like the one on the 
Windows desktop. Find the file in 
the list and right-click it, then select ‘Restore’ from the  
menu that appears. Your file should now be back in  
your OneDrive folder.

Get free space 
from alternative 
cloud services

DROPBOx Dropbox is a simple 
idea: a single folder on your PC 
that’s synced through the cloud 

and appears the same on every computer 
you sign into it on. There’s an app for most 
platforms – including mobile, where your 
files can be viewed and individually 
downloaded – but you only get 2GB of 
space for free. Upgrade options include 
1TB of space for £7.99 a month.

GOOGle DRIve
 Google’s cloud service offers 
15GB of storage space for free, 

and is tied in to the Google Docs online 
office suite that works very much like 
Office Online. Your storage space is 
shared across Drive, your Gmail inbox 
and Google+ photos. Upgrade options 
span from 100GB for £1.25 a month all 
the way to 30TB for £190 a month.

BT ClOuD If you’re a BT 
Broadband customer, BT Cloud 
offers up to 50GB of free space, 

depending on your package, as 
a bonus on top of your monthly 
broadband payment. BT Cloud works 
through an app on desktop and 
mobile devices that lets you decide 
what it backs up. Set it to watch your 
Documents folder, and anything that 
appears there is sent to the cloud.

O
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neDrive’s integration with 
other apps is one of its most 
powerful features. These 
apps come in two guises: 
those that use OneDrive as a 

storage area, allowing your data to appear 
on every device running the same 
program, and those that add OneDrive 
functionality to devices that otherwise 
wouldn’t have it. To get OneDrive on your 
Android phones and tablets there’s an app 
on Google Play, and Blackberry users will 
find one on Blackberry World. Windows 
Phone users can get it from Apps+Games 
if it’s not installed already, and Xbox One 
gamers can install OneDrive on their 
consoles. There’s even a plugin for the 
Chrome web browser you can install from 
the Web Store, but it seems to do little 
other than launch the OneDrive website. 

The website is a useful way of accessing 
files if you can’t install an app on the PC 
you’re using, as you can still upload and 
download the files you need manually. In 
this way, OneDrive becomes like a remote 
USB flash drive, allowing you to copy files 
and take them to another computer – as 
long as you’re connected to the internet.
The mobile apps work in a similar way. 
Because of the limited storage on mobile 
devices – 16GB isn’t an uncommon 
capacity, and many don’t have a microSD 
card slot to add more storage – syncing all 
your OneDrive files to them is impractical  

and could push up your phone bill if it’s  
using your mobile data connection. 

Mobile OneDrive apps display the 
contents of your OneDrive folders without 
immediately downloading their contents. 
You can browse files, choose the ones you 
need, then save them to your phone, but 
any changes you make to them will not be 
saved and synced to your other computers 
unless you re-upload the file to OneDrive.

OneDrive offers automatic camera roll 
uploading for mobiles, something it has in 
common with other cloud services such as 
Dropbox. This means if you take a snap 
with your phone it will upload to the cloud, 
and appear on your PC the next time you 
switch it on, without you having to connect 
the devices and copy the file over manually. 

OneDrive has some tough terms and 
conditions of any cloud service. Content 
placed in OneDrive is monitored, and 
anything that contravenes the service’s 
code of conduct is subject to removal, and 
the account that placed it there can face 
being closed down. Photos on OneDrive 
are scanned with Microsoft’s PhotoDNA 
tool, also used by Google and Facebook, 
and subject matter that contravenes the 
code of conduct includes nudity, and 
anything related to the purchasing of guns. 

The other type of app is aware of 
OneDrive, and syncs its data through it 
across devices without you needing to 
set it manually. There’s a small but growing 
number of apps that support this 
functionality, including OneNote, 3D image 
visualisation app Cooliris and Genius Scan 
+, which uses your phone to scan 
documents and upload them to the cloud.

These apps often come with a desktop 
counterpart, so OneDrive integration 
makes sense as you can view your work on 
a larger screen, and go on to share or print 
– perhaps including it into a PowerPoint 
presentation that will, in turn, be saved 
back into OneDrive and shared with 
multiple recipients.

tEAMWORk OneDrive is an excellent counterpart to many other apps on both your  
Windows pC and mobile devices

apps that work 
with onedrive
Gigabytes of storage are no good unless you put them to useifttt and 

onedrive

Onenote is an app first released 
by Microsoft 10 years ago, but 
recently made available for free on 
many different platforms. 
In essence it’s a notebook, and 
indeed its saved files – placed in 
OneDrive – are referred to as such. It 
may look like a word processor, but 
Onenote allows you to save pictures, 
drawings and text anywhere you like 
on its pages. Just tap or click 
somewhere and start typing – or 
write with a stylus or finger.

Onenote comes into its own on 
tablet computers. Its functionality is 
built into the Surface Pro 3, where 
clicking the Surface Pen will allow 
you to take a note even if the device 

has its screen locked. You can have it 
on your iPad and make a shopping 
list as you look through your kitchen 
cupboards that’s then synced to 
your Android phone ready for 
reading back when you’re at the 
supermarket. Or you can arrange 
pictures you’ve taken into the order 
you want, then view the 
arrangement on your desktop PC 
when you get home. notebooks are 
also available in a web browser at 
www.onenote.com

It’s a powerful and convenient 
way to take notes, especially with a 
touch interface, and the OneDrive 
syncing means you’re never far away 
from your most recent to-do list.

take note of onenote

O
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lIStEN up You can play music stored in your OneDrive account using the service’s mobile apps

hile Microsoft, at the time  
of writing, has yet to 
announce a music streaming 
service that includes 

OneDrive, the functionality is there 
within its mobile apps. 

If you upload your legally acquired 
MP3s to a folder on OneDrive, taking 
careful note of the recent changes to 
the UK’s copyright laws, which came 
into effect in September, and then 
access the folder from one of OneDrive’s 
mobile apps, you’ll find you can play the 

he default location of your 
OneDrive folder is in C:/user/
name/, but Windows 10 
removes the ability to move it 

to a more convenient location. 
In Windows 8.1 you could move the 

folder by right-clicking the OneDrive folder 
and selecting ‘Properties’. From there click 
‘Location > Move’. Point the following 
window to the new location you want, and 
click ‘OK’. The folder is then moved, without 
having to redownload the files. 

A workaround from the days of 
Windows 7 and 8 works in 10 though: 
right click the OneDrive icon in the 
notification area, select ‘Settings’ and click 
on ‘Unlink OneDrive’. You’ll go through 

Media streaMing

Move your 
onedrive folder

Listen to the music stored in your  
OneDrive account wherever you are

Make Microsoft’s cloud storage  
function around your needs

files from within the app on iOS,  
and using the built-in Sound Player 
app on Android. 

Of course, Microsoft has a full 
streaming music service called  
Groove Music that you should 
probably use instead, since it’s free  
for the basic version. 

You can also use the OneDrive 
website to play video files directly 
from your storage, as long as they’re in 
the MP4, QuickTime movie (.mov) or 
Apple video (.m4v) format.

the same setup procedure you did when 
you first started using OneDrive, and will 
have to wait until your files download 
from the internet into their new location 
before it’s finished. n

share a document 
from onedrive

CHOOSe TO SHARe
You can share documents and 
folders directly from OneDrive in 

Windows 10, and allow recipients  
to either read or edit them. From the 
desktop, locate the document you want 
to share and right-click it, then select 
‘More OneDrive Sharing Options’. Your 
web browser will open and load the 
OneDrive website, so you might need  
to log in.

ADD ReCIPIenT
Once logged in, you’ll get a 
screen like this one. If using 

an operating system older than 
Windows 8.1, you can share the file  
from the website and get to the same 
stage. Enter the email address of the 
recipient, and type a message in the box 
if you want. An email with the message 
and a link to the document will be sent 
to the recipient.

SeT PeRMISSIOnS
There are a couple of further 
options on the webpage, 

accessed by clicking the blue ‘Recipients 
can edit’ link. Here, you can choose 
whether your recipient can edit the 
document or merely read it – editing is 
useful for collaborating with workmates, 
but not ideal in every situation. Last is a 
toggle for whether or not the viewer 
needs to log in with a Microsoft account.MOvE It keep your OneDrive 

folder wherever you like

W

t

1

2

3

Your essential guide 
OneDrive
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Windows
I HAvE A LOcAL USER 
PRObLEm AFTER my 
WINDOWS 10 UPgRADE 

Q I updated my laptop  
from Windows 7 Home to 

Windows 10, opting to stick with 
my current local user account 
rather than use a Microsoft Account 

logon. However, the laptop has two 
user accounts – my wife’s and my 
own – and when starting, it boots 
directly to the user who was last 
logged in. We then log out to select 
the other user. Is there a way of 
interrupting this so we can choose 
who to log in as when booting?
mike Painter

graham’s solution
First off, let me start by 
saying this definitely 
isn’t normal behaviour. 

We instructed Mike to open the 
hidden User Accounts dialogue 
box (press [Win]+[R], type 
netplwiz and hit [Enter] to do so), 
which is where you normally 
configure Windows to 
automatically log on as a 
specified user. Mike discovered 
the “Users must enter a username 
and password to use this 
computer” wasn’t ticked, so ticked 
and rebooted, but it had no 
effect – the computer still booted 
straight to his desktop.

Mike subsequently revealed 
that neither his wife nor he had 
password-protected their 
accounts – and that adding 
passwords to both via the 
Accounts section of Settings 
resulted in the problem being 
solved. Windows 10 now halts at 
the lock screen on startup, 
allowing Mike and his wife to 
select their account before 
completing the login process.

Do you have a  
PC problem?  
Get in touch…
Email full details of your 
problem to the 
support team and we’ll 
do our best to help 
windowsmagazine@
futurenet.com

Desktop boot 
Windows 10 boots 

straight to the 
desktop without  

a password
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Jargon buster!

Networking
IP cONFLIcT 
cONUNDRUm 

Q My wife’s laptop will happily 
use our wireless connection 

right up until the point when I 
connect up to it. However, at this 
point her laptop loses the 
connection a few minutes after 
mine is switched on. She receives 
an onscreen error about IP address 
conflicts every few minutes, and 
whatever I do it cannot be resolved 
until my own laptop shuts down. I 
would appreciate your help!
John Wallis

Zak’s solution
The usual suspect – 
that both laptops 
had somehow been 

assigned the same IP address 
– didn’t apply in this case, 
particularly as the problem  
only occurred when John’s  
laptop was switched on. John 
revealed he had HomeNet 
Manager installed on his laptop 
for security purposes, and after 
uninstalling this discovered that 
his wife’s laptop could now 
happily coexist with his.

HomeNet Manager is no 
longer developed or supported 
– John was using it to add 
another layer of protection to his 
network. He’d already protected 
his wireless connection through 
password-protected encryption, 
disabling its SSID and filtering 
MAC addresses, which should 
provide more than adequate 
protection. If he wants to scan his 
network for possible intruders, a 
tool such as Advanced IP Scanner 
(www.advanced-ip-scanner.com) 
should suffice.

Security
DRIvERmAX WON’T RUN 

Q I’m unable to access DriverMax 
from either its desktop 

shortcut or the program file itself.  
It tells me that Windows cannot 
find the file, even though it’s  
still present on my PC. I’ve tried 
uninstalling and reinstalling to  
no avail – it also throws up a  
code 2 error when trying to run a 
related application, innostp.exe. 
Can you help?
Jack

mayank’s solution
The problem was 
confined purely to 
DriverMax, but when 

Jack discovered the code 2 error it 
confirmed our suspicions that some 
kind of anti-malware was blocking 

Quickfire questions

Find the solution! AskVG - Windows 10 tips and fixes
Vishal Gupta is one of Microsoft’s Windows Most Valuable 
Professionals - visit www.AskVG.com for Windows 10 advice.

I’ve forgotten how to 
bookmark web pages quickly 
in Firefox. Can you help?
Jochum beld

Press the [Ctrl]+[D] shortcut to 
bookmark a page (works in 
most browsers). Use [Ctrl]+[B] 
to access the Bookmarks 
sidebar, and [Ctrl]+[Shift]+[D] 
to bookmark all open tabs.
 
I believe my laptop contains 
malware so I plan to use the 
AVG rescue CD. Will it delete 
any of my drive partitions?
Peter claxton

No, the tool should not delete 
any partitions. Let it scan all 
your drives and run all 
available scans and reports to 
see what it finds.

“To scan a network for 
possible intruders, a tool 
such as Advanced IP 
Scanner should suffice”

 Local User Account 
This is a user account whose 
details are stored exclusively 
on the host PC, and can  
only be used to sign into  
that computer.

secure Wi-Fi use your router’s tools to tighten network security

poWer broWser 
run office apps 
directly in your 

web browser

Support 
Technical help
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2 Open Device manager
If problems occur after a botched 

upgrade, press [Win]+[R], type devmgmt  
and press [Enter] to access Device  
Manager. Look for the ‘Sound, video  
and game controllers’ section. Expand it,  
then double-click your sound device.

1 check playback device
Check the volume control in the 

Taskbar. If it’s marked with a red cross, 
right-click it and choose ‘Playback Devices’. 
Make sure your speakers are the default 
device (select them and click ‘Set Default’ if 
they’re not).

RESOLvE SOUND ISSUES
Q I tried updating my sound 

driver using a third-party 
program and it failed, leaving  
me with no sound. Can you  
help please? 
Jim Duncan

cat’s solution
There are a number of 
different steps you can 
take to resolve this 

problem – start by right-clicking 
the volume icon in the taskbar and 
choosing ‘Troubleshoot sound 
problems’ to see if Windows and 
detect and fix the problem for you. 
If not, read on.

Quickfire questions

chat, voice and video calls, and use 
a third-party password manager 
such as LastPass (lastpass.com) to 
keep your online passwords secure.

Apps
NO ROOm TO INSTALL 

Q Could you tell me if it’s 
possible to force Windows to 

install all programs onto my D drive 
instead of my Windows partition?
ben Drew

graham’s solution
Ordinarily we wouldn’t 
recommend this – 
but the best place for 

your program files is the Windows 
partition. Ben had a good reason 
for wanting to install programs on 
his D drive though: his PC had 
come with Windows installed on 
a 30GB solid-state hard drive, and 
he didn’t have the space to install 
the flight simulators that he 
enjoyed playing. While he’d 
been able to manually change 
the installation directory for some 
programs so they resided on his 
1TB data drive, he was unable to 
do the same for Real Environment 

How do I stop an ‘Upload 
failed’ message in Office 365 
that requires me to click a 
button to sign in to sync 
certain files?
Theresa Higgins

Right-click the OneDrive icon 
in the Taskbar and choose 
‘Settings’. Untick ‘Use Office to 
sync files faster and work on 
files with other people at the 
same time’. Click ‘OK’ to resolve 
this and similar errors.
 
Since upgrading to Windows 
10, Office 2003 won’t open files 
on a double-click. How can I 
resolve this?
Les Higgins

Office 2003 is not officially 
compatible with Windows 10, 
so if the known workarounds 
for resolving the double-click 
issue no longer work, you’ll 
need to switch to a different 
suite or upgrade to Office 2007 
or later.
 
I’ve been sent a file without a 
file extension by a friend. Is 
there some way I can find out 
what type of file it is?
Diane Twist

A free app called NTInfo 
(http://ntinfo.biz/) can detect 
over 200 file types – once you 
have the file extension, append 
it to the end of the file and it 
should now open correctly.

the execution of DriverMax without 
removing its files. DriverMax ships 
with OpenCandy, a form of 
potentially unwanted software, so 
it’s likely this is why the program’s 
flagged as dubious and is being 
blocked. Rather than try to resolve 
the problem, Jack decided to ditch 
DriverMax and use a different driver 
updater instead. We’re actually not 
fans of these driver update tools, 
particularly when keeping your PC 
updated on a day-to-day basis. 
They can be useful when trying to 
track down drivers for troublesome 
hardware – perhaps you’re looking 
for an update that can fix a 
problem or can’t find compatible 
drivers for an older piece of kit, but 
you’re better off relying on 
Windows Update or the driver 
manufacturer yourself.

Internet
INTERNET IgNORANT 

Q Can you advise me on what 
applications I need – other 

than a browser – for using the 
internet? This subject always gets 
overlooked when you instruct us 
on how to reinstall Windows.
george blakemore

Zak’s solution
These days, your web 
browser has gained 
more and more features 

that make it a one-stop shop for 
the vast majority of internet-related 
activities, from email and social 
networking to running full-blown 
applications in a browser window. 
Nevertheless, you may prefer to 
keep certain tasks separate, so first 
consider installing a separate email 
client, such as Windows Live Mail 
(essentials.live.com), Thunderbird 
(getthunderbird.com) or Opera Mail 
(opera.com/mail). Also consider 
Skype (skype.com) for staying in 
touch with friends and family via 

Move FolDer 
unlink oneDrive to 
transfer it to your 
preferred location
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Jargon buster!
 

 SSID (Service Set Identifier)
This is the name of your  
Wi-Fi network. It helps 
identify it to networked 
devices that wish to connect 
to it wirelessly. To authorise 
an app with Twitter, the 
service generates a long 
string of numbers that you 
need to copy and paste into 
TweetMyPC. This makes sure 
that only you have access  
to your Twitter account.

4 Use System Restore
If this fails, press [Win]+[Pause/Break]  

to open System Properties and click  
‘System Protection’ followed by ‘System 
Restore…’ Choose the latest available  
Restore point taken before you upgraded  
the driver.

3 Roll back driver
If no fixable problems are listed  

under ‘Device status’, switch to the Driver  
tab. If the ‘Roll Back Driver’ button isn’t  
greyed out, click the button and follow  
the prompts to reinstall the previous  
working driver.

“Ordinarily we wouldn’t recommend this – 
but the best place for your program files  

is the Windows partition”

Xtreme 2 for Microsoft Flight 
Simulator. In Ben’s case, it turned 
out the problem wasn’t with the 
program refusing to install to drive 
D, it was the fact it required 25GB 
free space during installation for 
the temporary files, which were 
being unpacked to the temporary 
folders on drive C. 

The solution is to move these 
folders to drive D: open System 
Properties by pressing 
[Win]+[Pause/Break] keys together. 
Select Advanced system settings, 
then click the ‘Environment 
Variables’ button. Select ‘TEMP’ and 
‘TMP’ in turn, click ‘Edit’ and then 
type D:\TEmP and D:\TmP for each 
entry respectively. Click ‘OK’ twice, 
create both folders on your D drive 
(Temp may already be present) and 
you should be able to install the 
program with no further problems.

Microsoft OneDrive
mOvE ONEDRIvE FOLDER 

Q I keep my OneDrive folder on 
a separate data partition. 

Recently I reset Windows 10 to fix 
some problems, but now OneDrive 
is trying to use a folder on my main 
Windows drive. How can I instruct it 
to use my data partition instead?
val Davies

Nick O’s solution
Right-click the 
OneDrive icon in  
the Taskbar Notification 

area and choose ‘Settings’. From 
the ‘Settings’ tab, click the ‘Unlink 
OneDrive’ button to reset 
OneDrive and launch the  
startup wizard. Sign in with  
your Microsoft Account and  
then you’ll be prompted to  
select where to store your 
OneDrive folder. Click the ‘Change 
link’ and select your existing 
OneDrive folder from the list 
– don’t worry about the warning 

about files already being  
present. Once selected, choose 
what to sync and let OneDrive  
get everything back to working 
order again.

Windows
WINDOWS UPDATE 
ISSUES bEFORE UPgRADE 

Q I reserved my free upgrade to 
Windows 10 three weeks 

before it was released, but have 
since had over 60 notifications in 
Windows Update that the upgrade 
has failed. When is this going to be 
sorted out? I’m a very disgruntled 
Windows user right now!
Philip caddick

matt’s solution
When we replied Philip 
revealed Windows had 
finally started 

downloading through Windows 
Update, but was stuck at ‘Checking 
requirements’. We advised him to 
cancel the process by restarting his 
PC and then upgrade manually 
using the Windows 10 Media 
Creation tool, from www.microsoft.
com/en-gb/software-download/
windows10. On doing this, Philip 
was able to report success. If you’re 
still waiting for your Windows 10 
upgrade to occur, try this route 
instead – and don’t forget to back 
up first!

Force upgraDe 
use the Windows 
Media creation 
tool to update to 
Windows 10

Do you have  
a PC problem?  
Get in touch…
Email full details of 
your problem to the 
support team and we’ll 
do our best to help: 
windowsmagazine@
futurenet.com 
Or write to the support 
team and we’ll do 
our best to help: 
Support Squad, 
Windows Help & 
Advice magazine, 
Future Publishing Ltd, 
Quay House, The 
Ambury, bath  
bA1 1AU

Support 
Technical help
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 new hardware   essential accessories   latest GaMes

here at Windows 
Help & Advice  
we have several  
offices – our main 
headquarters in  

the beautiful city of Bath,  
as well as our home offices, 
too. Therefore, it’s essential 
we have the right hardware to 
get the job done. The Epson 
Workforce with its refillable 
ink cartridges is shaping up to 
be a promising addition at 
home, while Samsung’s latest 
4TB portable hard drive is 
ideal for keeping back-ups 
and magazine archives safe.   
     But it’s not all work,  
we’ve been having plenty  
of fun with the GoPro HERO4 
Session, too – turn to page  
90 to find out why. Until  
next time!

Nick Odantzis deputy editor
nick.odantzis@futurenet.com

Welcome

The Upgrade section is your key to finding out about the latest 
products, all designed to help you get more from your PC

ratinG explained Superb GoodVery good Disappointing Poor

Our promise to you…

You can trust our reviews
Our reviewers are 100 per cent 
independent, with years of 

experience in the world of computing. 
Our rigorous testing procedures mean 
that only genuine, high-quality 
products are awarded high star ratings. 
If you see an item of hardware bearing 
a high score, you can be confident that 
it is an excellent product.

we choose the best products
Thousands of new PC products 
are released every year and 

choosing between them can be an 
impossible task. Our experts select only 
the best hardware and software to 
feature in this magazine. Even better, 
our star rating system makes it simple 
to find the best products, giving you a 
fast, trustworthy guide.

84 Lenovo ThinkPad Yoga 15
A powerful laptop with one sturdy  
design and many different positions

80 Epson Workforce ET-4550
The printer that breaks the mould  
by offering all the ink you need

82 Samsung M3 Portable 4GB
A record-breaking hard drive that’s a 
must-buy for reliable back-up storage

86 GoPro HERO4 Session
Create great-quality video footage  
wherever your adventures carry you

how we review
Our expert reviewers guarantee  
to test every piece of hardware 

rigorously and thoroughly, using  
only acknowledged experts to 
establish the worth of a product.  
We always review from the viewpoint 
of our readers; the day-to-day 
practicality and quality of a product  
is paramount.

pB  |    |  August 2015 November 2015  |    |  79

This issue’s highlights

88 Mini test Compact system cameras

page://80
page://82
page://84
page://86
page://88


T here are plenty of affordable, 
easy-to-use home and 
small-office inkjet printers 

on the market. And usually they 
tend to stand out from 
competitors based on print speed 
and quality. However, a new 
contender has emerged that 
provides a unique value 
proposition. And that is tons and 
tons of cheap ink.

The Epson WorkForce ET-4550 is 
a member of the new Epson 
EcoTank line of printers. Each of 
the new machines come with a 
compartment designed to house 
dramatically more ink than your 
standard colour printer.

Compared to similar Epson 
all-in-ones, each of the five new 
EcoTank models are capable of 
storing the equivalent of up to 20 
previous-generation ink 
cartridges. That equates to at least 
two years of ink, or 11,000 black 
pages or 8,500 colour pages.

The ET-4550 is a workhorse 
printer that produces moderately 
fast prints with little to no image 
complexity or colour accuracy. But 
at least it will print and print and 

print without you always having 
to think about when to replace 
the ink.

Design
The ET-4550 is composed of a 
matte black plastic that won’t 
collect fingerprint smudges or 
dust very easily. The printer 
features several compartments, 
including an upper tray, a 
scanning bed that holds up to an 
8.5 x 14-inch sheet, a collapsible 
front-facing output tray that holds 
up to 150 A4 pages, and a tray that 
can hold up to 20 envelopes and 
other small form-factor pages.

To the right of the extensive 
5.6cm mono graphics display is a 
series of buttons, including a 
number pad, a direction pad and 
a start button for both black and 
colour prints. On the far right-
hand side of the unit is the bulky 
compartment where the ink is 
held. On a typical printer, your ink 
cartridges are housed within the 
body of the unit. With the ET-4550 
Epson chose function over form 
by adding a three-inch-wide, 
four-compartment container to 

the right-hand side of the unit, 
into which black, cyan, magenta 
and yellow ink bottles are poured.

The added three inches gives 
the unit an unorthodox look and 
feel. Most printers of this class 
have boxy designs that are 
intended to be overlooked. The 
ET-4550 stands out, and not in a 
good way, because of the jutting 
ink container.

That said, this shouldn’t be a 
deal breaker for anyone. After all, 
you’re getting a ton of ink with 
your purchase. However, if 
maximum desk space is 
important, or you like to have a 
stylish environment, this extra 
compartment is an eyesore.

When you unbox the ET-4550 
you’ll remember why you bought 
it in the first place. It comes with 
four bottles of ink, three colour 
bottles and one massive bottle of 
black ink. Although the bottles 
don’t specify how much liquid is 
contained within, it’s 
approximately 200ml of black ink 
and 100ml for the colours.

Either way, Epson claims this is 
enough to keep you printing for 
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More ink than you’ll probably ever need



really need. But if you’re trying to 
print photos of your daughter’s 
birthday party, or if you need to 
run off a ton of copies quickly, 
look elsewhere.

Features
Let’s be honest, you won’t be 
interested in this printer for its 
speed or quality. You want a ton 
of ink and you want to get that ink 
cheaply. Well, you’ve succeeded. 
With the ET-4550, you’re getting 
8,500 colour prints for about £35.

Also, the printer works with 
Epson Connect print and share 
technology, which enables you to 
access the device from mobile 
phones and tablets. It also works 
with Google Cloud printing, 
Mopria, Kindle Fire Print and 
Apple AirPrint, so you’ll never be 
left in a lurch. 

We often hope for the day when 
we’ll never have to load another 
ink cartridge into a printer. At 
11,000 pages per bottle, Epson has 
come closer to this dream than 

If your main concern is keeping 
costs down, this might be the 
ideal printer for you.

more than two years. A new set  
of bottles will only cost £30.

However, be careful when 
emptying the bottles into the 
compartments. They leak and 
spill easily. Epson provides you 
with gloves for this dirty work, 
and you’ll need them. Once 
your printer is full of ink, getting 
the ET-4450 to work is fairly 
straightforward, but it is a lengthy 
process, as it needs a 20-minute  
ink calibration.

In addition to the calibration 
process, you’re walked through 

several quick steps, such as 
connecting to Wi-Fi and changing 
your time zone, all of which are 
simple, thanks to Epson’s setup 
process and button navigation. 

Specs and performance
The ET-4550 measures 250 x 35 x 
24cm and is just 7.2kg. As for 
performance, manufacturer-
provided specs can be quite 
deceiving. Despite claiming print 
speeds of 13 black pages per 
minute and five colour pages per 
minute, we were only able to print 
five Word documents in black and 
white in 60 seconds. It failed to 
print even one colour image in 
under a minute, and took two 
minutes to produce a colour 
photo on plain paper.

These speeds are pretty slack, 
especially for a workforce printer. 
You can accept 13 black images 
per minute if the image quality 
was top-notch, like the Canon 
Pixma MG7520. But with a top 
resolution of 4,800 x 1,200 dpi, the 
ET-4550 needs to be much, much 
faster than it is.

To provide some context: the 
Canon Pixma MG7520 produces 12 
black images per minute. The 
Canon Maxify MB5320 gets you up 
to 23 images per minute, and the 
Epson Workforce Pro WF-4630 can 

get you 20. The ET-4550 gets 
dusted by all of these devices.

You can adjust your PCs settings 
to produce lower quality prints at 
faster speeds. 

Small business owners should 
be wary of these below-par 
speeds. Imagine having to print a 
10-page PowerPoint presentation, 
and then standing at the printer 
for 20 minutes waiting for the 
document to emerge? The prints 
don’t come out badly, though. The 
blacks are bold and the bright 
colours pop. However, there isn’t 
much contrast here; your darks 
fade into one another and the 
detail output isn’t complex. If you 
need a printer for company 
memos and homework 
assignments, then this is all you 

“When you first unbox this printer you’ll quickly 
remember why you bought it in the first place”
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Epson Workforce ET-4550

KEY FEATURES

Epson Workforce ET-4550
Print speed 13 black ipm, 5 color ipm 
Print resolution 4,800 x 1,200 dpi 
Paper sizes Up to 8.5 x 47.2-inch 
Paper capacity 150 sheets 
Dimensions 250x35x24cm  
Weight 7.2kg 



While most recent storage 
breakthroughs have 
mostly involved SSDs and 

non-mechanical technologies, hard 
disk drives still hold most of the 
world’s data. Also, for the majority 
of us, they are the only financially 
viable option for bulk, mass storage 
beyond the terabyte mark.

The 4TB Samsung M3 Portable 
otherwise known as the HX-
M401TCB/G was launched a couple 
of months ago, and it’s the perfect 
example of how far spinning, 
traditional hard disk drives have 
moved over the past 10 years.

It took 2.5-inch models a mere 
three years to catch up with their 
bigger 3.5-inch cousins and while 
the capacity of the latter only 
doubled over that period, that of 
the smaller devices has quadrupled 
since 2011.

Storage density
Managing to cram 4TB into such a 
small volume means another thing 

– the Samsung M3 Portable offers 
by far the highest storage density 
of any hard disk drive on the 
market. The drive measures 
82x118.2x19.85mm, which 
translates into a volume of 192 
cubic centimetres and a storage 
density of just under 21GB per cm3.

Samsung Storage, which was 
purchased by Seagate a few years 
ago, managed to offer such a 
storage capacity by squeezing five 
800GB platters into the drive.

While we didn’t manage to pry 
open the device’s case, the drive 
used appears to be a Momentus 
one from Seagate, the 
ST4000LM016 (AKA Spinpoint 
M10P), a model that doesn’t even 
appear on the HDD maker’s 
website. CrystalDiskInfo states that 
it has 16MB cache and a rotational 
speed of 5400RPM.

What it didn’t highlight was the 
fact it is one of the first, if not the 
first 2.5-inch SMR hard drive on the 
market. SMR or Shingled Magnetic 

Recording is a storage technology 
that allows more data to be 
crammed on a platter in a way 
that’s similar to shingles on a roof 
(hence the name).

Its biggest flaw though is  
the fact it is much slower than 
traditional hard disk drives when 
having to deal with random writes 
for small files – one solution would 
obviously be to compress them 
into one big one to accelerate the 
file transfer.

On the outside, the drive is 
similar to many of its competitors. It 
sits comfortably in the palm of a 
hand, has an indicator LED, a flat 
USB 3.0 connector, but there’s no 
power button. The Samsung logo 
adorns the top fascia, which itself 
sports what the manufacturer calls 
a durable black design. 

Performance
The drive comes with a three-year 
warranty as well as a number of 
bundled applications, the main 

Samsung M3 Portable 4TB
£150 | $230 www.samsung.com

Meet a record-breaking hard disk drive…
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for storage. Seagate’s own Backup 
Plus 4TB USB 3.0 drive might be its 
only real competitor. Since they 
probably share the same drive, it is 
likely that they will perform 
similarly. That drive is slightly more 
expensive but comes with a useful 
Mobile Backup App and two years’ 
subscription to OneDrive cloud-
based storage with 200GB. That’s 
worth £4 a month or £96 over the 
duration of the subscription.

Note that this drive is also 
available as the P3 Portable with a 
slightly different form factor. This 
sample was provided by Samsung 
and as always (and especially with 
drives of this capacity), we would 
strongly urge you to back up your 
hard disk drive. ■

This drive is a must-buy if you’re 
looking for a reliable storage 
device for files and backups.

one being Samsung Drive 
Manager, which comprises 
AutoBackup – a backup solution, 
unsurprisingly – SecretZone, a data 
protection solution, Secure 
Manager, a secure external HD 
management solution and 
Samsung’s External HD 
management tools.

It was one of the better 
performers on PCMark 8 in recent 
memory and easily the best 
5400PM portable drive we’ve seen 
for a long time, its score of 2139 
being fractionally higher than that 
of the 3TB Toshiba Canvio.

This drive is surprisingly 
affordable, managing to offer one 
of the cheapest cost per TB of this 
category. The Samsung M3 
Portable is a flagship device that is 

affordable, and relatively fast 
despite using SMR, plus it has 
enough storage capacity to fit a 
billion songs (or MP3 tracks). We 
couldn’t fault its design and it 
comes with an adequate 
software package. In fact, there’s 
hardly anything to dislike about 
this drive. Once you understand 

the way SMR works, you can’t really 
criticise the poor performance for 
random writes.

Final verdict
The Samsung M3 Portable is a 
fantastic product despite its 
slightly boring appearance. 
Seagate has keenly priced this 
SMR-capable drive and its sheer 
value for money should make it 
popular among those craving 

“The Samsung M3 Portable 4TB is a fantastic  
product despite its slightly boring appearance”

Upgrade 
Samsung M3 Portable 4TB
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KEY FEATURES

Samsung M3 Portable 4TB
Supplier Samsung
Operating system Windows 8/7/Vista, 
Mac OS X 10.4.8 or later
Performance specification SuperSpeed 
USB 3.0 (Max) 4.8Gb/s
Storage 4TB
Software AutoBackup personal backup 
solution, Secure Drive for worry-free data 
security,  SecretZoneTM can encrypt data 
on the device
Weight 236g
Size 82x118.2x19.85mm 



Lenovo, the pioneer of the 
convertible space, has sought 
to change the way you work 

with its ThinkPad Yoga machines. 
And that’s regardless of whether 
you’re after a home-use laptop, or if 
you’re a business user who has 
previously had very few convertible 
options to choose from. 

What you’ll love about the 
ThinkPad Yoga 15 is that it is 
capable of shifting between 
Laptop, Stand, Tablet and Tent 
modes, while switching your 
system settings and locking your 
keyboard when necessary.

This means your screen can flip 
360 degrees from closed to Tablet 
mode, and your hardware keyboard 
will deactivate in this mode so you 
don’t accidentally disrupt your 
navigation or content consumption.

Unfortunately, there aren’t many 
cases for a 2.3kg tablet. Although 
the laptop is thin, at just 21mm, its 
bulk makes it somewhat clumsy 
when trying to flip the screen back 

and over. This isn’t an issue if the 
notebook is sitting on a desk, but if 
you’re standing, or using the laptop 
on your lap, you’ll wish you had a 
smaller 11- or 13-inch device.

The two metal hinges 
connecting the display to the 
ThinkPad Yoga 15’s base are 
incredibly sturdy. However, 
because the upper panel weighs so 
much, when you try to put the 
laptop in Tent or Display mode, the 
hinges give just a bit.

The laptop is built with a black 
magnesium-alloy frame and a 
plastic vent-heavy bottom plate. 
The top plate feels sturdy and is 
extremely resistant to scratches and 
dust. After more than a week of 
transporting the device around, the 
device didn’t get a single scratch.

The bottom of the laptop is less 
sturdy than the lid, but the plastic 
bottom does serve a purpose 
though: after more than several 
hours of use, we didn’t feel any 
heat emanating from the unit. 

The 15.6-inch, Full HD (FHD) – 
that’s 1,920 x 1,080 pixels – 10-point 
multitouch display is  vibrant. 
Colors are bright and detailed, and 
the added width and height will 
ensure that you don’t regret going 
with a smaller model. Although 
navigating a 15.6-inch touchscreen 
can be burdensome at times, the 
DragonTrail display was super-
responsive and  accurate.

The spill-resistant keyboard 
sports Lenovo’s signature AccuType 
curved keys, also the clickpad is the 
perfect size, and incredibly 
smooth. The added number pad, 
which can’t be found on smaller 
ThinkPad Yoga units, is a coup for 
business users who are forced to 
input heavy amounts of data 
throughout the day.

Power trip
We found the 2.2GHz to be 
speedy enough to get us through 
a few days of work (and plenty of 
Netflix bingeing). However, the 

Lenovo ThinkPad Yoga 15
£629 | $929 www.lenovo.com

A powerful laptop with one sturdy design and many different positions
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Our verdict
If you like large laptops and don’t 
mind some extra weight, there’s 
not much to dislike about the 
Lenovo ThinkPad Yoga 15. It 
features a stellar 9.5 hours of 
battery life, to start.

The laptop’s also packing a pretty 
FHD screen that’s housed in a 
gorgeous and durable magnesium 
alloy chassis. It packs enough ports 
to get you any connection you 
might need. And finally, this 
notebook’s performance is on par 
with similar devices in this class.

Unfortunately, a 2.3kg laptop is 
essentially a portable desktop. You 
won’t want to drag this device 
around, and even if you do, you 
likely won’t use it in Tent or Display 
mode because of how clunky it is.

Lenovo packed this machine with 
a gorgeous screen, a solid trackpad 
and a good selection of ports. If 
you don’t mind a few extra pounds, 
then it’s ideal for the business user 
who seldom needs portability, but 
enjoys having the option. ■

The Lenovo ThinkPad Yoga 15 is a 
dynamite device that is capable of 
being many different things.

machine did sputter when we ran 
several benchmarks.

The 8GB of RAM and 150GB of 
storage we have on the review unit 
isn’t going to wow anyone, but the 
device can be compromised a bit to 
reduce the RAM to 4GB in order to 
cram in 500GB of storage.

You’ve got all the ports you’ll  
need to get you through a workday. 
The absence of an Ethernet port is 
annoying, but we have to accept  
adapters and docking stations are 
the norm these days.

Although the Yoga doesn’t pack 
as much power as other similar 
machines, it’s got a much newer 

and better chipset than the Envy, 
for instance, which is still powered 
by Intel’s previous generation Core 
i5 processor.

If you upgrade to the highest 
level ThinkPad Yoga 15, you will 
receive a processor that is on par 
with the MacBook Pro, but  
you’ll spend considerably less  
than you will with Apple. However, 
the MacBook Pro has a much 
higher resolution screen that  
is much more suitable for  
graphic designers, videographers 
and photographers.

In our suite of benchmarks, the 
ThinkPad Yoga 15 proved itself 
worthy of any head-to-head 

comparison with the Envy 360 and 
the MacBook Pro. The ThinkPad 
Yoga demolished the Envy in the 
3DMark graphics test, with a Fire 
Strike score of 1,448, compared to 
the Envy’s 504 points.

In the PCMark 8 test, the 
ThinkPad finished with an 
impressive speed that merited 
2,357 points, which is comparable 
to the Envy, which scored a slightly 
lower 2,322.

Battery life is where the ThinkPad 
gets to flex its muscle against the 
Envy. The latter only scored 3 hours 
and 53 minutes in the PCMark 8 
battery test, whereas the Yoga 15 

made it to 5 hours and 7 minutes. 
In real-life testing, the Yoga 15’s 
battery lasted for 9 hours and 35 
minutes of video playback with the 
screen brightness and the volume 
set to 50%.

Compared to the MacBook Pro, 
which scored a whopping 310 
points, the Yoga scored a slightly 
lower 251 points in the CineBench 
CPU test, which measures the 
processor’s hyperthreading 
performance through image 
rendering. Unfortunately for the 
Yoga, the MacBook was able to stay 
powered for 12 hours and 4 
minutes on a similar video test, a 
difference of almost three hours.

“You’ll receive a processor on par with the MacBook 
Pro, but you’ll spend considerably less money on it”
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Upgrade 
Lenovo ThinkPad Yoga 15

KEY FEATURES

ThinkPad Yoga 15
Manufacturer Lenovo
Operating system Windows 8.1 64
Processor Intel Core i5-5300U (dual-core, 
2.20GHz, 3.0MB cache, up to 2.9GHz with 
Turbo Boost)
Storage 150GB SSD OPAL2
RAM 8GB
Graphics Intel HD Graphics 5500
Ports 2 USB 3.0, 1 USB 2.0, HDMI, 4-in-1 
card reader (MMC, SD, SDHC, SDXC)
Connectivity: Intel Dual-Band Wireless – 
AC WLAN + Bluetooth 4.0 
Weight 2.3kg
Size 15.07 x 0.82 x 10.07 inches 
Screen size 1,920 x 1,080, 10-point multi-
touch display 
Camera HD 720p



The square box style has 
become popular for action 
cameras, and with the HERO4 

Session, GoPro is the latest to 
launch a camera in this style. The 
design is 50 percent smaller and 40 
percent lighter than previous 
HERO4 cameras. It also includes 
other improvements, such as being 
waterproof to 10m without 
housing, and there’s a one-button 
operation to make capturing the 
action easier than ever.

There’s little to fault with the 
design of the Session. The small size 
of the camera, encased within a 
skeleton frame, makes mounting 
and positioning it easier than ever. 
The camera can be rotated within 
the frame to the correct orientation 
and this, coupled with the auto 
orientation feature, ensures your 
footage is always the right way up.

A quick press of the shutter 
button powers on the camera and 
begins shooting video; press and 
hold the button and it starts 

capturing time-lapse sequences. A 
second press of the shutter button 
stops recording. The GoPro app is 
required to access other shooting 
modes, and to adjust settings.

On the back of the camera is a 
button which, when pressed, 
displays settings and status 
information on the LCD next to the 
shutter button. The back button 
also activates the Wi-Fi function 
and tags footage, depending on 
the camera’s status. On the side of 
the camera is a pop-out flap that 
gives access to the MicroSD slot, 
and a Micro USB port for charging 
the built-in battery. 

The Session needs to be placed 
inside the included frame in order 
to be mounted; a pressure lever 
holds the camera firm. At the base 
of the frame is the standard GoPro 
mount, which is compatible with 
the majority of GoPro accessories. 
This frame and the new ball joint 
buckle also enable low-profile 
mounting, a welcome innovation 

compared with the more traditional 
GoPro accessory mounts.

Wi-Fi and app
You need to pair the camera with 
your iOS or Android device and use 
the GoPro app to access the full 
range of shooting modes and 
settings. Wi-Fi set-up and pairing is 
straightforward, and the app gives 
you access to a variety of options 
and modes – you can adjust the 
resolution, frame rate and camera 
modes, and remotely operate the 
camera and live view. 

There’s a good choice of quality 
settings, including 1440p at 30fps, 
1080p at 60fps and 720p at 100fps. 
There are plenty more frame rate 
options, as well as a choice of NTSC 
or PAL formats. All video is 
recorded in H.264 codec in the 
.mp4 file format, making it  
compatible with most editing 
applications, as well as with the 
excellent GoPro Studio. Video buffs 
can also make use of the ProTune 

GoPro HERO4 Session
£270 | $399 www.gopro.com

It’s hip to be cubed
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hour and a half of video. The GoPro 
HERO4 Session builds on the 
success of the HERO series. Its small 
size, and the ability to use the 
frame and ball-joint bracket to 
enable low-profile mounting, will 
appeal to extreme sports 
enthusiasts. The simple one-button 
operation is a nice touch, and the 
small screen showing that video 
recording has started might be 
simple, but it’s also reassuring.

As with the rest of the HERO 
range video quality is good, and 
the GoPro app gives you plenty of 
control over settings.

Final verdict
GoPro is dominant in the action-
camera market, and with the 
launch of the Session it shows they 
will innovate to stay ahead.

The Session’s size, design and 
simple operation make it an ideal 
choice for those who want to 
capture the action with minimum of 
fuss. However, it’s that simplicity that 
limits your ability to change settings 
without the mobile app, and the 
price makes it hard to justify when 
compared to the competition. ■

The design makes for easier 
mounting and operation, and 
video quality is as good as ever.

settings, which give control over 
sensitivity and sharpness.

Adjusting settings via the GoPro 
app is quick and intuitive, and you 
can check settings by switching to 
the remote control feature. The app 
also features live view, so you can 
check composition and exposure, 
and adjust settings as needed.

The interface features a start/
stop record button, and additional 
icons enable you to change modes 
quickly. The app also enables you 
to play back footage, and upload 
direct to the GoPro community.

GoPro cameras have become 
known for their high video quality, 
and the Session is no exception. 

Once connected to the app, the 
camera gives you a good selection 
of resolutions to choose from, and 
while these might not be the 
headline-catching 4K’s of the 
HERO4 Black, they will enable you 
to edit and view your footage 
smoothly on a home computer.

The visual quality of the footage 
is excellent, with bright punchy 
colours and sharp detail. The lens 
gives the standard fisheye 
perspective, and looking at the 
footage there are no pronounced 
signs of detail becoming soft 
toward the edges, or signs of 
chromatic aberration.

Colours are reproduced well and 
the footage has a bright, clean look. 
Exposure is well controlled in good 

lighting conditions, and the Session 
copes well when moving from 
shade to bright, adjusting the 
exposure quickly and smoothly. 
The quality of the live view stream 
via the app is good, although it is 
necessarily dependent on the 
strength of the Wi-Fi signal. In good 
conditions the stream is smooth, 
with less than a second’s delay 
between the action happening and 
it appearing on screen.

In tests, we found that the range 
was limited to around 10 metres, 
which is adequate – with action 
cameras, live view is generally a 
tool for checking composition, 
rather than for remote recording.

One issue we encountered when 
using the Session was the length of 
time between the record button 
being pressed and the start of 
recording – this could be in excess 
of five seconds, and it turned out to 
be an issue with the MicroSD card.

After a little experimentation, we 
found cards from Lexar or SanDisk, 
meant the delay between hitting 
the shutter button and the start  
of recording dropped to just over 
two seconds. 

Even though the Session is 50% 
smaller than the HERO4 Black, it still 
manages to compare favourably 
when it comes to battery life. In our 
tests, with Wi-Fi switched off and 
shooting 1080p at 60fps, the 
camera comfortably captured an 

“It’s waterproof to 10m, and a one-button operation 
makes capturing the action easier than ever”
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Upgrade 
GoPro HERO4 Session

KEY FEATURES

GoPro Hero4 Session
Video resolution 1440p, 1080p,  
1080p SuperView, 960p, 720p,  
720p SuperView, WVGA
Photo resolution 8MP, 5MP
Video format H.264 codec,  
.mp4 file format
Audio Format 32kHz sampling rate,  
AAC compression
Internal mic Mono x 2
External mic Not supported
Storage microSD memory card with at 
least a Class 10 or UHS-I rating required; 
up to 64GB capacity supported
Ports Micro USB, microSD memory card
Battery Rechargeable lithium-ion 
battery, rated at 1000mAh, 3.8V, 3.23Wh, 
integrated with camera
Weight 74g



1 Panasonic LUMIX 
DMC-GF7
£429.99 (with 12-32mm lens) 
panasonic.co.uk

Narrowing the gap between the 
output quality of a compact and a 
digital SLR, the 16MP GF7 
incorporates a 17.3 x 13mm Four 
Thirds sensor. Video is Full HD. There’s 
a 180-degree tilting touchscreen 
display, but no viewfinder. A 240fps 
AF drive and a 12-32mm lens ensure 
response times are quick, and the  
GF7 produces sharp, colourful  
images. It offers remote operation 
via your smartphone, too, with  
the relevant app.

3 Sony A7 II 
£1,500 (body only) sony.co.uk

The A7 II shows semi-pro mettle, with 
a full-frame sensor (the largest in its 
class) of up to 24.3MP resolution. 
Weightier lenses are now ably 
supported via optical five-axis image 
stabilisation, providing 4.5 stops of 
extra brightness. Auto-focus and 
start-up times are quicker, thanks to a 
117-point phase-detection AF sensor 
working with 25-point contrast-
detection AF, which ensure sharpness 
no matter where the subject is in the 
frame. Operation resembles a DSLR, 
with a forward-placed shutter-release 
button, a front-control wheel and a 
2.36-million-dot electronic viewfinder.

2 Fujifilm X-T10 
From £499 (body only) fujifilm.co.uk

The 16.3MP X-T10 spoils us with a 
2.36-million-dot electronic viewfinder 
and a big APS-C sensor. It’s built to 
last, with die-cast magnesium top and 
base plates, plus three aluminium 
control dials. Manual control is a treat, 
but flick the auto-mode lever for 
simple point-and-shoot operation. The 
49-point AF mode delivers high-speed, 
supremely sharp and accurate focusing 
with naturalistic colours, while action 
shots benefit from 8fps burst shooting. 
We like the three-inch, 920K-dot-
resolution tilting monitor, with pop-up 
flash. Add an 18-55mm standard zoom 
for £300.

1

45Pocket  
Pros
Professional pictures, 
solid build, smaller 
proportions – it’s time 
to invest in a compact 
system camera

he best camera is always 
the one you have with 
you. so while that’s 

made smartphones an obvious 
choice, anyone looking for a 
dedicated camera with a larger 
sensor and better light-gathering 
ability should step up to a 
compact system camera (csc).

essential features to look out 
for are compatibility with a wide 
range of lenses, as well as the 
largest possible sensor size – full 
frame, APs-c, Four thirds or 
one-inch. other features might 
include an electronic viewfinder 
and/or a tilting touchscreen LcD, 
while a growing number of 
models are becoming as adept at 
shooting video as they are at 
taking photos. Here’s our top six.

T
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6 Nikon 1 J5
From £349 (body only) nikon.co.uk 

With its one-inch sensor size physically 
larger than the 1/2.3-inch chip found 
in most point-and-shoots, if smaller 
than most CSCs and all DSLRs, the 
20.8MP J5 is the most grown-up J 
series camera yet. The key ‘hook’ is 4K 
video capture – a first for Nikon, 
ensuring the J5 joins a select handful in 
Panasonic’s GH4/GX8, Samsung’s NX1 
and Sony’s A7s – all heftier, pricier 
cameras. Yet the J5’s maximum frame 
rate is a paltry 15fps, not the more 
cinematic 30fps. It does feature a 
flip-up, three-inch, selfie-enabling 
screen, and its 10-30mm compact 
zoom kit is fair value at £430. 

4 Olympus 
OM-D E-M5 II
From £899 (body only) olympus.co.uk 

A doppelganger of the E-M1 flagship 
camera, the E-M5 II is marginally heavier 
because of a new shutter mechanism 
and a tilt ‘n’ swivel LCD screen. This is a 
boon for Full HD video, as is the five-axis 
in-body image stabilisation. For stills, 
choose the Four Thirds CMOS sensor’s 
16MP mode or a new 40MP mode, 
which combines eight successive shots 
for a final image that’s processed in 2.5 
seconds. The E-M5 II is splashproof, 
dustproof and freezeproof. Pity there’s 
no built-in flash, but it has a clip-on 
FL-LM3 accessory flash. 

5 Canon EOS M3
From £599.99 (with lens) canon.co.uk 

More akin to a compact than a DSLR, 
the miniaturised EOS has a very large 
APS-C sensor with a maximum 
resolution of 24.2MP, and a pop-out 
flash. It has the creative flexibility of a 
rear-panel touchscreen that tilts up by 
180 degrees, down by 45 degrees, or 
faces the subject. A kit option includes 
an 18-55mm zoom for sharp, 
colour-rich results. A 49-point AF 
system and Canon’s Digic 6 processor 
ensure swiftness yet reliability. As the 
camera is consumer-targeted, it offers 
Wi-Fi and NFC connectivity for sharing 
your shots, making it a good first step 
up from a smartphone camera.

3

6
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Welcome
Whether you’ve 
just installed 
Windows 10, or 
you’re still 
wondering if it’s 

worth the upgrade, then 
you’ve come to the right 
place. Windows 10 can be a 
leap into the unknown for 
some people, and we’re here  
to give you the confidence to 
take the initial steps. 

In this section, you’ll find 
advice on how to upgrade to 
Windows 10, as well as a short 
tutorial showing how it works 
and what you need to do first. 

And don’t forget to let us 
know how you’re getting on! 
Email us on windowsmagazine@ 
futurenet.com.

Matt Hanson  
Associate Editor 

Featuring…

windows 10 tip of the month Customise your version of Windows 10

You can view notifications from various 
apps by adding them to your PC’s lock 
screen, which is the screen that appears 
when your computer is waiting for you 
to log in. Navigate to ‘Start > Settings > 
Personalisation > Lock screen’ and scroll 
down to the ‘Choose apps to show quick 
status’ section. Click on any of the grey 
boxes and pick an app from the list to 
view their status on the lock screen. 

Add apps to your lock screen

Windows 10

lock screen view showing calendar appointments 
in the lock screen could serve as a handy reminder

battery life bear in mind that lock screen badges  
will drain your laptop’s battery while fetching data

Turn To  
page 14 

for more 
windows 10 

help

Welcome to…

www.facebook.com/windowsmag
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92 Installing Windows 10 is easy to 
do – read our no-nonsense guide 
for all the tips and advice you need

 
 

94 With your operating system 
installed, we show you how to get 
started with the new features
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WindoWs 10    
Bring your PC up to date with the latest version of Windows 10 

– it could be the last time you’ll ever upgrade…
indows 10 offers 
many new features 
and improvements 
from previous 

versions. Features include 
Cortana and the Edge web 
browser, as well as Windows-
standard security tools, such as 
secure boot and Windows 
Defender. If you’re currently 
using Windows 7 Starter, Home 
Basic or Home Premium, or the 
standard Windows 8.1, this is 
the version you’ll get as part of 
your free upgrade.

Windows 10 Pro is designed 
for more advanced operation, 
and includes a few more 
features, including the ability 
to host a Remote Desktop 
session, additional data 
security with Bitlocker and the 
Encrypted File System (EFS), 

Installing

additional networking 
components, and Hyper-V, 
which allows the creation of 
virtual machines. 

Windows 10 is also making 
its way to mobile devices with 
the Mobile and Mobile 
Enterprise editions, which will 
replace Windows Phone 8. 

Get installing
Installing, as you’ll find out, is 
reasonably straightforward. 
Upgrading from within 
Windows is even easier. In our 
testing, we lost no files or 
installed programs, although 
you may see a few default 
Windows apps disappearing – 

Windows 7’s Solitaire and 
Hearts, for example, will not 
transfer because Windows 10 
has its own versions. 

Windows 10 maintains a 
high level of compatibility with 
previous versions, and we’re 
yet to encounter any software 
that doesn’t work as it did on 
the Windows 8.1 desktop.

If you’re eligible for the free 
upgrade – that is, if you’re 
running a licensed copy of 
Windows 8, 8.1 or 7 with at 
least Service Pack 1 installed – 
you’ll see a windows logo in 
the taskbar at the bottom-right 
corner of your desktop. Click to 
get Windows 10 for free. 

But there’s more than one 
way to upgrade, and several 
things to bear in mind when 

you do so. Here we cover 
everything you need to know!

Back up first
While it’s unlikely anything will 
go wrong, a new install is a 
good excuse for a backup! Safe 
data should be stored in its 
original location, with copies in 
two other different locations. 
You will need to use an 
external drive and online cloud 
storage. Most free services 
offer a limited amount of 
space, so only place your most 
critical files here. Services such 
as Carbonite or CrashPlan, 
which charge a subscription 
fee, offer more options, and do 
the hard work for you.

The key location to have 
backed up is your personal 
folder, which will sit within the 
Users folder on your main 
drive. This includes your 
libraries – Documents, Photos 



Windows 10 
Installing
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Windows 10 
keyboard 
shortcuts
1. [Alt]+[Tab]
Switch between open apps

2. [Alt]+[F4]
Close the active item, or exit 
the active app

3. Windows logo key+[L]
Lock your PC or switch 
accounts

4. Windows logo key+[d]
Display and hide  
the desktop

5. Windows logo key+[A]
Open Action center

6. Windows logo key+[s]
Open search

7. Windows logo key+[C]
Open Cortana in  
listening mode

8. Windows logo key+Tab
Open Task view

9. Windows logo 
key+[Ctrl]+[d]
Add a virtual desktop

10. Windows logo 
key+[Ctrl]+Right arrow
Switch between virtual 
desktops you’ve created on 
the right

11. Windows logo 
key+[Ctrl]+ Left arrow
Switch between virtual 
desktops you’ve created on 
the left

12. Windows logo 
key+[Ctrl]+[F4]
Close the virtual desktop 
you’re using

and the like – and your 
Windows desktop. But do be 
warned it won’t cover 
absolutely everything safely.

There’s a small chance you’re 
very organised, and you know 
where every file of a given type 
resides on your hard drive. 
There’s a larger chance 
everything is scattered in 
separate places, so you’ll need 
to dig everything up. Use 
Windows’ search facility to find 
what you’re looking for; open 
up Computer in an Explorer 
window and use the search bar 
at the top to search for, for 
example, ‘*.jpg’ to find all of 
your photos, or ‘*.mp3’ for your 
music. Select the files from 
your searches and copy them 
to your external drive and, if 
you have space, to your chosen 
cloud service.

Time to upgrade
To upgrade to Windows 10, just 
click the icon in your System 
Tray and proceed. Or, you 
might want to do clean install. 
If you have a copy of Windows 
10 on DVD, put it in your 
optical drive, restart your 
machine, and it’ll boot from 
the disc. If it doesn’t, you’ll 
need to change a setting in 
your computer’s BIOS/UEFI to 
put the optical drive first in the 
boot order. We can’t be specific 
about exactly what setting to 
change and how, given the 
wide variety of BIOS and UEFI 
systems out there, but watch 
out for a message displayed on 
your PC’s screen at boot time 
– you might see a window in 
which to hit an allotted key, 
usually [F2] or [Del]. If you 
know the model of your PC, 
check the manufacturer’s 
website for more instructions.
The process is also true if 

you’ve transferred an ISO 
image to USB for installation; 
while there are more steps to 
take, as long as your install 
media is set to boot first, you’ll 
be fine. You’ll need to ensure 
you have your drive inserted 
into a port before you boot to 
BIOS in order to set this up. 
Once you’re running the 
installer, follow the instructions. 
The Windows 10 install process 
is more simple and foolproof 
than before, and if you’re 
careful not to let it overwrite a 
partition you’re using, you’ll 
likely have no problem.

But wait! Hold fire if you’re 
looking to dual boot Windows 
10 with 7 or 8.1; before you 
install, unless you happen to 
have a spare partition, you’ll 
need to use the Disk 
Management tool within your 
old OS to resize your primary 
partition and separate off space 
for Windows 10 to install into. 

But wait… again! Before you 
resize your partition, make sure 
your files are arranged by 
defragmenting it, leaving space 

at the end to be reallocated. 
Right click your primary drive 
in Windows Explorer, select 
‘Properties’, open the Tools tab, 
and click ‘Defragment now’. 
Now click Defragment Disk to 
start the process. Launch the 
Disk Management tool by 
opening the run dialog with 
[Windows]+[R] then typing 
diskmgmt.msc. The interface 
shows the partitions that exist 
on your machine – you’ll 
probably have at least two, a 
small recovery partition and a 
much larger main partition, 
and it’s the latter we’re 
interested in. Check in the 
volumes list at the top of the 
window that your chosen 
partition has enough free 
space (at least 16GB for 32-bit 
Windows 10 and 20GB for 
64-bit, allocating more if you 
can). If you’re short on space, 
clear some files before 
continuing. Right click your 
target drive in the Disk 
Management tool and select 
‘Shrink Volume’, then input the 
amount of space you’re 
looking to claw back. Be aware 
that the tool is looking for this 
in MB rather than GB, so add 
three zeroes to the end of your 
intended space in GB. Click 
‘OK’ and the tool will go to 
work, and you’ll be left with an 
area on your drive labelled 
‘unallocated space’. We now 
need to turn this into a 
partition. Right click it, select 
‘new simple volume’, and click 
‘Next’. You can give this new 
partition any letter you like. 
Keep clicking ‘Next’ until you 
see the formatting options. 
Make sure you choose ‘NTFS’ 
as the file system, and label 
your drive before formatting 
the space. 

manage well Use the 
Disk management tool 

to help with your install

Boot Up Installing from a disc? then you might need to visit your UeFI system 



Learn how to…
Get started with 
Windows 10

“Now you’ve finally got Windows 
10 installed, it’s time to find out 
what it has to offer”

ow you’ve got Windows 10 installed, up and 
running, it’s time to see how the new system works. 
There’s a new Start menu for you to explore and 

some exciting new features. For example, when it comes to 
aiding productivity Windows 10 has plenty on offer. 
Whether it’s aero snapping your apps to corners or asking 
Cortana to help you out by setting reminders, it’s all there 
to streamline your daily computing. 

The best approach is to dive right into as many of the 
settings as you can – personalising your operating system, 
desktop and programs for the tasks you perform the most.

For instance, if Cortana isn’t your thing, or you prefer  
not to search on the desktop through Bing then you can 
remove that part from the taskbar at the bottom of the 
page. Doing this will give you more screen space, as well  
as a tidier desktop and leave you with more space to pin 
programs to. But, these are just a few ways to improve  
your Windows experience, read on to learn more.

1 Set up your screen resolution
To help increase your productivity make sure your screen is 

running at maximum resolution. You’ll find text and images are 
much clearer and easier to see. Right click on an empty area of 
your desktop and select ‘Display Settings’. You can now select 
‘Advanced Display Settings’ in the right-hand window. Here you’ll 
find the Resolution drop-down menu – select the highest option.

2 Switch to Tablet mode for 2-in-1 laptops
Open the Start menu and select ‘Settings’. Here you’ll  

find some tools you can configure to make your life easier. Go to 
System then Tablet mode. Enabling Tablet mode will make 
Windows 10 act more like Windows 8 – your apps will be fully 
sized and your Start Menu will expand to the entire screen. Ideal 
for 2-in-1 laptops and touchscreen all-in-ones.

Step-by-step Get started with Windows 10

Jargon buster!
 Resolution

The resolution is how 
many pixels occupy 
the screen. The 
higher the resolution 
the more dots and 
the clearer your 
images will be.

 Snapping
A way of arranging 
and resizing 
windows, by 
dragging them  
to the edge of  
your screen.
  

 Partition 
A separate segment 
of your drive split  
off to organise  
and protect your  
files from viruses  
or data loss.

Your guide Zak Storey says…

SettinGS
The Settings tab is 
the new control 
panel, you’ll find 
many customisation 
options easier to 
change here. 

ReSolution iS key
Setting up your screen 
correctly will ensure 
you can be as 
productive as 
possible, and save 
your eyesight as well. 

N
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3 Aero Snap in Windows 10
Snapping programs to the sides of the screen was a feature 

introduced in Windows 7. In Windows 10 you can now snap 
applications to each corner, as well as to the sides, by left clicking 
and dragging the top bar into a corner. You will also see a visual 
representation of how much screen space the app will take up. 
This makes it much easier to multitask with two documents.

4 Uninstall programs
Uninstalling old and unused programs can be useful for 

freeing up storage space on your PC. You’ll also notice your 
start-up times become speedier if you declutter. To do this, click 
‘Settings’ in the Start Menu, select ‘System’ then on the left tab 
select ‘Installed Apps’. Here you can remove apps by left-clicking 
them and selecting ‘Uninstall’.

BackuP
It’s always a good idea 
to create a backup of 
files and documents, 
so you don’t have to 
worry about losing 
your work. 

Multi-aPP VieW
This little button 
makes switching 
between apps 
much easier. 

SPace SaVinG
Removing old programs 
frees up storage space 
and means Windows 
won’t have to load  
up as many programs 
on startup. 

coRtana
Your personal 
assistant, ask it for 
anything and it’ll see  
if it can help, or just 
search the internet  
for an answer. 

Zak’S beSt tip!
Explore all the menus to 
discover all the options on 
offer. We guarantee you’ll 
find plenty of shortcuts  
and tricks that will soon 
become indispensable.
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9 Multi-App view
Another neat feature is the ability to swap between many 

apps at any time. Just press ‘Task view’, the button to the right of 
the search bar near the Start menu. This allows you to quickly 
switch between open applications (including minimised ones) 
without having to trawl through the icons on your task bar, 
making it much easier to find programs.

7 Cortana on call
If you’re signed into your Microsoft account you can use 

Cortana for many things from searching the internet, to setting 
calendar reminders or sending emails. To get going, just say “Hey 
Cortana” (making sure your mic is enabled) or type Cortana into 
the search bar at the bottom left-hand of your screen. If it can’t do 
something for you it’ll search the internet for the answer.

5  Create a secure backup
You’ll need around 120GB of excess storage in a separate 

partition or drive to create a secure backup of your PC’s OS and 
documents every week. Go to ‘Settings’ and select ‘Update & 
Security’, then click on ‘Back-up’ in the left-hand window. Click on 
the ‘+’ button and select the partition or drive you wish to use. 
Once done select ‘more options’, then ‘See advanced settings’.

10 Uninstalling the old Windows
So, it’s time to bid farewell to Windows 7 or 8 on your PC! To 

uninstall it, click on the Start menu and type in disk clean up, 
then open the ‘Disk Clean Up’ application. You can now select 
drive (C:), press ‘OK’ and let Windows scan the drive. Scroll down 
the open window and tick ‘Previous Windows Installation(s)’ tab, 
select ‘Clean up system files’ and you’re done. ■

8  Organise mail accounts into one
Keeping all email accounts in one place was a handy feature 

introduced in older versions of Windows 8. However, the Mail app 
that replaced Outlook has much more increased functionality. 
Click on the Mail icon in your Start window select ‘Add account’, 
select your email service and fill in the details. You can now select 
‘Done’ and all your emails will be in one place.

6 Finish the backup
Now click ‘System Image Backup’ in the bottom left-hand 

corner of the screen, and click ‘Set up Back-up’ on the right-hand 
side of the screen. Highlight the drive you want to use for your 
backup and click ‘Next’, then ‘Let Windows Chose’. Hit ‘Next’ again. 
You can now set up the schedule for when Windows performs the 
backup and then press ‘Save settings and run backup’.
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